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Preface

1. About Mandriva Linux
Mandriva Linux is a Linux distribution supported by Mandriva S.A., which was born on
the Internet in 1998. Its main goal was and still is to provide an easy-to-use and friendly
Linux system. Today, Mandriva's activity lies on three pillars: simplicity, openness and
innovation. Mandriva's distribution is the result of the best of Open Source, based on the
collaboration between Mandriva and its contributor community.

On April 7th 2005, the Mandrakesoft company changed its name to Mandriva to
reflect its merger with Brazil-based Conectiva. Consequently, its core product,
Mandrakelinux, became Mandriva Linux.

1.1. Contacting Mandriva Linux Community

The following are various web links pointing you to the most important Mandriva Lin-
ux-related sources. If you want to know more about the Mandriva company, connect to
the Mandriva web site [http://www.mandriva.com/]. You will find information concerning
Mandriva Linux distributions and derivatives.

 Mandriva Expert [http://expert.mandriva.com/] is Mandriva's online support platform. It
offers a new experience based on trust and the pleasure of rewarding others for their con-
tributions.

We also invite you to subscribe to the various  mailing lists [http://wiki.mandriva.com/en/
Development/Mailinglists] where the Mandriva Linux community demonstrates its high
spirits and keen debates.

 Please also remember to connect to our Security page [http://www.mandriva.com/securi-
ty/]. It gathers all security-related material about Mandriva Linux distributions. You will
find security and bug advisories, as well as kernel update procedures, the different secu-
rity-oriented mailing lists which you can join, etc. This page is a must, for any server ad-
ministrator or user concerned about security, which completes tools available in the dis-
tribution.

1.2. Joining Mandriva Community

Mandriva Community is the place where users, developers and translators meet to help
each other out, exchange valuable information about Mandriva Linux, get informed about
the latest Mandriva, Linux and Open Source news and also participate to the design of
future distributions.

http://www.mandriva.com/
http://www.mandriva.com/
http://expert.mandriva.com/
http://expert.mandriva.com/
http://wiki.mandriva.com/en/Development/Mailinglists
http://wiki.mandriva.com/en/Development/Mailinglists
http://wiki.mandriva.com/en/Development/Mailinglists
http://www.mandriva.com/security/
http://www.mandriva.com/security/
http://www.mandriva.com/security/
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To join this community, you only need to create your personal Mandriva ID (you can
obtain it for free by subscribing to My Mandriva [http://my.mandriva.com]). You will have
access to:

• help (forums, chat, Knowledge Base with tutorials, how-tos, tips and tricks),

• news,

• much Mandriva and community-contributed content,

• and the official Mandriva Linux documentation.

Mandriva Community is where you get the best Mandriva Linux experience, learning from
others, teaching others, accessing exclusive features and contributing to the development
of Mandriva Linux and Free and Open Source Software in general.

1.3. Purchasing Mandriva Products

 You can purchase Mandriva products on-line through the Mandriva Store [http://
store.mandriva.com]. You will not only find Mandriva Linux solutions but also special
subscription offers, support, third-party softwares, documentation, Linux-related books,
as well as other Mandriva goodies.

We couldn't close this section without mentioning one of Mandriva flagship products:
Mandriva Flash is a pre-installed Mandriva Linux distribution on a simple 8GB USB 2.0
key. You only need to plug the key in your computer to start your Linux system anywhere.
You can also save and exchange your data on this key.

1.4. Contributing to Mandriva Linux

The skills of the many-talented folks who use Mandriva Linux can be very useful in the
making of the Mandriva Linux system.

• Packaging.  A  Linux system is mainly made of programs found on the Internet.
These need to be packaged in order to work together and to update safely.

• Programming.   There are many projects directly supported by Mandriva: find the
one that most appeals to you and offer your help to the main developer.

• Writing Documentation.   Be it for inline help in the installer or the Control Center,
or for the various manuals accompanying the Mandriva Linux flavors, new material is
always required. If you feel like sharing your knowledge in a structured and pedagog-
ical way, join us at the Wiki [http://wiki.mandriva.com/en/Development/Tasks/Docu-
mentation].

http://my.mandriva.com
http://my.mandriva.com
http://store.mandriva.com
http://store.mandriva.com
http://store.mandriva.com
http://wiki.mandriva.com/en/Development/Tasks/Documentation
http://wiki.mandriva.com/en/Development/Tasks/Documentation
http://wiki.mandriva.com/en/Development/Tasks/Documentation
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• Internationalization.   Mandriva Linux is translated in more than 70 languages. You
can help us translate web pages, programs and their respective documentation.

Consult the Community page [http://www.mandriva.com/en/community/] on Mandriva
official website.

2. About this User Guide
The aim of this manual is to give you a better understanding of the Mandriva Linux system.
In it, we focus on graphical applications that allow you to perform your daily tasks, such
as writing documents and e-mails, surfing the Web, and listening to music. We also show
you how to configure your desktop to your liking, install software, and to configure the
whole system in general.

3. Conventions Used in this Book

3.1. Typing Conventions

Formatted Exam-
ple

Meaning

inode Used to emphasize a technical term .

ls -lta Used for commands and their arguments. (see Section 3.2.1,
“Commands Synopsis” [xvi]).

a_file Used for file names. It may also be used for RPM package
names.

ls (1) Reference to a man page. To read the page, simply type man 1
ls, in a command line.

$ ls *.pid Formatting used for text snapshots of what you may see on your
screen including computer interactions, program listings, etc.

localhost Literal data which does not generally fit in any of the previously
defined categories. For example, a key word taken from a config-
uration file.

OpenOffice.org Defines application names. Depending on context, the applica-
tion and command name may be the same but formatted differ-
ently. For example, most commands are written in lowercase,
while applications names usually begin with an uppercase char-
acter.

http://www.mandriva.com/en/community/
http://www.mandriva.com/en/community/
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Formatted Exam-
ple

Meaning

 Files Indicates menu entries or graphical interface labels. The under-
lined letter, if present, informs you of a keyboard shortcut, acces-
sible by pressing the Alt key plus the letter in question.

Le petit chaperon
rouge

Identifies foreign language words.

Warning! Reserved for special warnings in order to emphasize the impor-
tance of words. Read out loud.

Highlights a note. Generally, it gives additional information about a specific
area.

Represents a tip. It could be general advice on how to perform a particular action,
or hints about nice features, such as shortcuts, which could make your life easier.

Be very careful when you see this icon. It always means that very important
information about a specific subject will be dealt with.

3.2. General Conventions

3.2.1. Commands Synopsis

The example below shows the symbols you will see when the writer describes the argu-
ments of a command:

command <non literal argument> [optional arg -...]

These conventions are standard and you will find them elsewhere such as in the man pages.

The “<” (lesser than) and “>” (greater than) symbols denote a mandatory argument not to
be copied as is, which should be replaced according to your needs. For example, <file-
name> refers to the actual name of a file. If this name is foo.txt you should type
foo.txt, not <foo.txt> or <filename>.

The square brackets (“[ ]”) denote optional arguments, which you may or may not include
in the command.

The ellipsis (“...”) means an arbitrary number of arguments may be included.

The curly brackets (“{ }”) contain the arguments authorized at this specific place. One of
them is to be placed here.



Quick Install

xvii

3.2.2. Special Notations
From time to time, you will be asked to press, for example, the keys Ctrl+ R, which
means you need to press and hold the Ctrl key and tap the R character right after as well.
The same applies for the Alt and Shift keys.

We use capital letters to represent the letter keys; this doesn't mean that you
have to type them capitalized. However, there might be programs where typing
R is not the same than typing r. You will be informed about this when dealing
with such programs.

Regarding menus, going to menu item File → Reload user config  ( Ctrl+ R ) means:
click on the File text displayed on the menu (generally located in the upper-left of the
window). Then in the pull-down menu, click on the Reload user config  item. Furthermore
you are informed that you can use the Ctrl+ R key combination (as described above) to
get the same result.

3.2.3. System-Generic Users
Whenever possible, we use two generic users in our examples:

Queen Pingusa queen This is our default user, used through most
examples in this book.

Peter Pingus peter This user can be created afterward by the
system administrator and is sometimes
used to vary the text.

4. Quick Install
If your computer is not already installed with Mandriva Linux you only need the installa-
tion media (DVD or CDs), very basic computer skills (of the “move the pointer and click”
kind), common sense, and a few minutes.

Installing Mandriva Linux implies copying the required system and application files on
your system and answering a few questions regarding the system's configuration and se-
curity. Once this is done, all that is left is to fine tune your system... and enjoy it. We
concentrate on installation here. System configuration and security are subjects we touch
upon in the rest of this book.

4.1. Performing the Installation
If your computer already has another operating system installed, you might want to first
check the notes in Section 4.2, “Co-existing with Other Operating Systems” [xviii].
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All recent systems can boot from a CD-ROM, configure your computer to boot from the
CD, insert the 1st CD (or the DVD), boot the system and follow the on-screen instructions.

The installer asks you some simple questions regarding the desired language, keyboard
layout (if applicable), security level, disk partitioning scheme and package selection; it is
usually safe to accept the defaults proposed.

Please refer to Part III, “Installing Mandriva Linux” [169] if you have doubts about
what to answer on any given install step.

4.2. Co-existing with Other Operating Systems
You can install Mandriva Linux alongside other operating systems, such as Windows®, or
other versions of Linux. Have the documentation for those OSes handy and make sure you:

1. Backup existing data. This is always the safest choice to ensure no data is lost.

2. Defragment the disk . This is mostly needed with all variants of Windows®. Linux file
systems have very little fragmentation, so there is no need to defragment them.

3. Make room for Mandriva Linux. 10 GB can be enough depending on what you want
to do with it. Note that the installer itself can resize existing installations of Windows®

and Linux without the risk of losing data.

Once Mandriva Linux is installed, and the system is restarted, a menu appears from which
you can select the operating system to start: use the arrow keys to highlight the one you
want, then press Enter  to boot it.



Part I. Free Software Daily

Using Mandriva Linux on a Daily Basis
The following chapters introduce the applications available under Mandriva Linux for your
daily needs.
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Chapter 1. Discover
your New Environment

1. Discovering the K Desktop Environment

  This chapter introduces the K Desktop Environment (KDE). It discusses where to find
your usual folders, and how to customize your desktop. It also talks about how to search for
files and introduces the concept of KDE sessions. The range of features KDE offers as well
as its degree of personalization is huge and you are encouraged to refer to its integrated
help to learn more about this great desktop environment.

1.1. The Desktop

Figure 1.1. The KDE Desktop
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KDE is very much like any modern desktop. In the figure above, you see the desktop itself,
and the panel sitting at the bottom.

1.2. The Panel

Figure 1.2. The KDE Panel

The panel is the bar which sits, by default, at the bottom of your desktop and contains the
following main components:

 The Main Menu.  Allows you to access the software installed on your system.
It is the equivalent of the Start Menu of Windows®. Programs are arranged into convenient
categories, so you can quickly and easily find the applications you want to run.

 Home Folder.  Opens a file browser displaying your home folder. It also allows
to navigate to other parts of the file systems, and even to remote devices. See Section 1.3,
“Virtual Desktops” [4] for more information.

Various Launchers and Applets.  You also find some icons to launch applications
(Firefox or Thunderbird for example) and other useful applets at the far right: a calendar,
network status and config, sound control, etc.

1.3. Virtual Desktops

Think of virtual desktops as having several screens available but with only one monitor.
By default, you have 4 “virtual” desktop to organize your applications.

To switch between virtual desktops use the following keyboard shortcuts :

Ctrl+ F1
to switch to first desktop

Ctrl+ F2
to switch to second desktop

Ctrl+ Fn
to switch to nth desktop
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You can also move application windows from one desktop to another. To do so, right click
the window title, and choose To Desktop ... .

When you log in into KDE, the virtual desktop you were in when you closed your last
session is re-opened.

2. How to Access Folders
If you come from the Windows® world, you may be a bit disoriented at the beginning, but
once you know how folders are organized, you will see how simple it is to find your usual
folders, access removable media (CDs, DVDs, USB storage devices, etc.), and external
resources.

2.1. Welcome Home!

Click  on the “Rocket” bar to open the folder containing your personal files.

Figure 1.3. Home Folder Content
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These are some folders already present on your personal folder which you can use to better
organize your data:

Documents
This is where all the documents you create are saved by default. It corresponds to the
My Documents folder on a Windows® system.

Downloads
This is where the files you download from the Internet are stored. It corresponds to
the My Downloads folder on a Windows® system.

Music
This is where your music is saved by default. It corresponds to the My Music folder
on a Windows® system.

Pictures
This is where pictures you download from your digital camera are saved. It corre-
sponds to the My Pictures folder on a Windows® system.

Videos
This is where you can store all your videos. It corresponds to the My Videos folder
on a Windows® system.

You can create, remove, and rename files and folders inside your personal (Home) folder.

2.2. Accessing Other Folders

 You can also browse the file system tree by opening the Root folder on the Places
sidebar. These folders contain your system configuration settings and the installed pro-
grams, as well as other things. If you need to change the system's settings, use the Mandri-
va Linux Control Center (refer to Part II, “Configuring and Tweaking Your Box” [27]
for more information).

2.3. Accessing Removable Media

Removable media is auto-detected on medium insertion, which makes accessing and man-
aging CDs, DVDs and USB storage devices easy.
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Figure 1.4. A CD Has Been Inserted

Just click on a device to open a list of possible actions.

2.4. Accessing Remote Shares

You can easily access shared resources on remote systems on your network with the file
manager. Here's how:

1. Open your Home folder

2.

 Open Network on the Places sidebar.

3. Open Samba Shares .

4. Select a system whose content you want to view, and navigate down to the resource
that interests you.
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Figure 1.5. Accessing Remote Shares

You can then access the files on the share as if they were located on your own system.

3. Personalizing Your Desktop

 Use the Configure your Desktop applet1 to customize your desktop features (see
Figure 1.6, “KDE System Settings” [9]). Configurable features are grouped into cat-
egories, for example to change the screen resolution click on Display and Monitor  inside
the Hardware category.

1The System Settings applet replaces the KDE Control Center present in previous Mandriva Linux versions.
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Figure 1.6. KDE System Settings
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3.1. Changing Your Desktop's Appearance

Figure 1.7. Changing KDE's Color Scheme

Click on Application Appearance inside the Common Appearance and Behavior  category,
then on the Colors  section (see Figure 1.7, “Changing KDE's Color Scheme” [10]).
In the Scheme tab you are proposed a list with predefined color schemes, select the one
you like and click Apply .

You can also define custom color schemes: Open the Colors  tab, select the item you want
to change from the list and click the color button. Then, choose the color you like and click
OK to apply it.

Once you have customized your color scheme, open the Scheme tab again and click on
Save Scheme to store your color scheme for later use. Fill its name and click OK. Click-
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ing Remove Scheme removes the currently selected customized color scheme, predefined
color schemes cannot be removed.

Figure 1.8. Changing KDE's Background Wallpaper

To change the desktop background right click on an empty place in the desktop and choose
Folder View Settings . Select the View category, and choose a picture or click the open
button to browse for your own pictures. Configure other settings to your liking and click
on OK to accept.
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3.2. Customizing Your Panel

KDE's panel is highly customizable. All features, from the panel's position to its appear-
ance and the icons it has, can be set up to better suit your preferences. Right click on the
panel and choose Panel Settings  from the menu2. The panel settings window (see Fig-
ure 1.9, “Panel Settings Window” [12]) appears near the panel. Drag the panel settings
window and drop it at the desired edge to move the panel from the bottom edge to a dif-
ferent edge.

Figure 1.9. Panel Settings Window

The panel adjusts its size dynamically to fit its contents. Use the sliders located on the left
and right to set the position, minimum and maximum size of the panel;.

You can also enrich the panel with the applets or plasmoids you use most frequently to
have them handy. Click on the Add Widgets  button in the panel settings window, select
the one you want then click on Add Widget . In the example (see Figure 1.10, “Adding a
Battery Monitor to the Panel” [13]) we add a battery monitor. Click on the red minus
icon to remove an existing widget.

2If the panel has its widgets locked, you will have to unlock them first, select Unlock Widgets  from the menu
that pops up.
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Figure 1.10. Adding a Battery Monitor to the Panel

With the Panel Settings window open, hover the mouse over a widget and a move emblem
 appears, click on the widget, move it to its desired location, and click again

to place it there.

4. Searching for Files

You can use Dolphin, KDE's file manager, to find files on your disk, proceed as follows:

1.

open your home folder  from the panel to launch Dolphin.

2.

click  from the menu to open the search dialog.

3. Enter the name of the file you are looking for. You can use a star (*) to mean “any-
thing” or a question mark (?) to mean “any single character”.
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4. press enter  to launch the search. Results are displayed below.
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Chapter 2. Doing Office Work
Abstract

  Mandriva Linux can be used to perform office work with the LibreOffice office
suite: we show you how to create documents with LibreOffice Writer, spreadsheets
with LibreOffice Calc and presentations with LibreOffice Impress. LibreOffice tools
are Microsoft ® Office-compatible, meaning that you can easily exchange docu-
ments between them.

 With LibreOffice, you can export your documents in PDF format

(choosing File → Export as PDF  from the menu). This allows you to publish
your documents in the Adobe ® Reader ® format.

1. Writing Documents

  Choose Office+ LibreOffice Writer  from the main menu to launch LibreOffice
Writer.
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1.1. Word Processor Interface

W o r k
Ar e a

P a g e
S t y le

In s e r t io n
P o in t

F o r m a t  Ba r

Ru le r s

Figure 2.1. LibreOffice Writer's Main Window

Format Bar.  This is the standard format bar for all LibreOffice applications which you
can use to change fonts, colors, alignment, etc. of the application's data.

Rulers.  Define the horizontal location of the text and format elements. Rulers are very
useful when you want to establish tabulation and paragraph indentation.

Work Area.  Where you enter the content of your document: words, numbers, images,
tables, hyperlinks, etc.

Insertion Point.  All characters typed on your keyboard will be placed at the left of this
point. Also called the cursor.

Page Style.  Many elements define style: page size, margins, text-orientation, etc. Page

style can be changed by choosing Format  → Page from the menu. You may use the
predefined styles, or define your own.



Styles

17

1.2. Styles

Word processor users often waste a lot of time formatting their documents: changing para-
graph alignment, font family, weight and size, etc. Instead, they should concentrate on
document structure and content writing.

 Styles provide a structure-centric approach to writing documents with a word pro-
cessor, while normalizing document formatting and layout, and easily automating the gen-
eration and maintenance of tables of contents (TOC), indexes, references, etc. In Libre-
Office Writer, styles are handled using the Stylist. Click on its icon in the Format Bar to
open or close it.

Table 2.1. Suggested Text Styles

When you have a... Then apply the ... style

Chapter Title Heading 1

Section Title Heading 2

Sub-Section Title Heading 3

Sub-Subsection Title Heading 4

Paragraph Text Body, First Line Indent

List Item List

Use the styles listed in Table 2.1, “Suggested Text Styles” [17] as a guide. Select the
region of the document to apply the style to, and in the Stylist window, double-click on
the style you want to apply to that region.

1.3. Lists

Use lists to enumerate the properties of an object ( “unordered” or “bullet” list), or the
steps to be performed to do a task (an “ordered” or “numbered” list).

 Click on this button to format the selected text into an unordered list. Select the list

items and choose Format  → Bullets and Numbering  from the menu to select the bullet
type from a predefined set.
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 Clicking on this button formats the selected text into an ordered list. The same rules
as for unordered lists apply to the numbering format.

1.4. Page Headers and Footers

By default, page headers and footers are common to all pages of a document. Use them
to describe aspects of a document's content, for example: page number, total number of
pages, chapter, section, document title, etc.

Choose Insert+ Header → Default  from the menu to add a page header to your docu-

ment, and choose Insert+ Footer → Default  to add a page footer to your document. Just

type the header or footer text or use one or more of the Insert  → Fields menu items to
compose your headers and footers.

2. Calculations and Simulations

  Choose Office+ LibreOffice Calc Spreadsheet  from the main menu to launch
LibreOffice Calc.
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2.1. Spreadsheet Interface

F o r m a t
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Figure 2.2. LibreOffice Calc's Main Window

Format Bar.  This is the standard format bar for all LibreOffice applications, you can
use it to change fonts, colors, alignment, etc. of the application's data.

Formula Bar.  Use it to enter, edit or delete formulas inside cells.

Work Area.  This is where you enter the data in the spreadsheet: numbers, dates, for-
mulas, images, etc.

Select All.  Clicking on this little area at the top left corner of the Work Area selects
all cells at once. It's useful when you need to make changes which are “global” to the
spreadsheet. For example, changing all font sizes in the cells to 10pts(points).

Sheet Changing Buttons and Tabs.  Spreadsheets usually contain more than one sheet.
You can use these buttons to easily navigate through each of the spreadsheet's sheets. From
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left to right they are: Go to the first sheet, Go to the previous sheet , Go to the next sheet
and Go to the last sheet. You may also use the tabs to switch between sheets.

2.2. Entering Data

To enter data into a cell, navigate to the cell and type the data into it, pressing the Enter
key when you are finished.

Auto-completion simplifies data entry “guessing” the next cell's value using the current
cell's value as a base. It works for any kind of data which can be associated to a simple
series of integral numbers.

Figure 2.3. Simplifying Data Entry Using Auto-Completion

To use auto-completion, put your mouse over the base cell “handle”(the little square lo-
cated at the bottom right of the cell border), click on it and drag the cell. The cell values
are then shown in a tool-tip (see Figure 2.3, “Simplifying Data Entry Using Auto-Com-
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pletion” [20]). Release the mouse button to complete the cells once the desired final
value is shown.

Cell data can also be sorted according to different criteria. Select the cells you want to sort

and then open the sort options dialog choosing Data  → Sort from the menu. Specify the
sort criteria, order and additional options and click on OK to sort the cells.

Make sure you also select columns and rows which act as “headers” for the data
so they “follow” the sorting of the data.

2.3. Adding Formulas

Formulas can be used to “automate” the spreadsheet. For example, you can run complex
simulations. Within cells, formulas are defined by preceding all cell data with the = sign.
Anything else is treated as “static” data.

Operations are expressed using conventional algebraic notation. For example,
=3*A25+4*(A20+C34/B34) divides the value in cell C34 by the value in cell B34,
adds the value in A20 to the result, multiplies that by 4 and adds it to 3 times the value of
cell A25. Therefore, rather complex expressions can be made using simpler ones as a base.

LibreOffice Calc gives you many pre-defined functions which you can use in your formu-

las. You can explore them by choosing the Insert  → Function  menu.

 You can also click on the function wizard button for assistance with
formula entry.

2.4. Charts: Explaining Data in a Simpler Way

When a spreadsheet contains too much information, it becomes difficult to understand how
pieces of data relate to one another: too many numbers and too little meaning. The best
way to represent this kind of data is through a chart.

As in all data-analysis functions, you must select the region you intend to show in the chart.

So, select a range of cells and then choose Insert  → Chart from the menu to bring up
the chart assistant.

Make your selections for the chart type, variant, title, axis titles, etc., and then click Create
to create and insert the chart in the spreadsheet (see Figure 2.4, “A 3D Chart Inside the
Spreadsheet” [22]).
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Figure 2.4. A 3D Chart Inside the Spreadsheet

Charts are “dynamic” in the spreadsheet, which means that when you change
data in a cell belonging to a chart, the chart is automatically updated.

Double clicking and then right-clicking on an inserted chart brings up a menu
showing options to change many chart parameters.

3. Communicating Your Ideas

  Choose Office  → LibreOffice Impress Presentation  from the main menu to
launch LibreOffice Impress. A wizard offers you assistance for creating a presentation, but
we won't detail it here. Just create an empty presentation by clicking Create .
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3.1. Presentation Interface
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Figure 2.5. LibreOffice Impress' Main Window

Slide Format Bar.  There are options for changing the slide shading, background color,
line thickness, etc.

Work Area.  This is where you compose the slides which build your presentation.

Toolbar.  Contains the main tools you use to create your slides: the text, shapes, curves,
lines and arrow input; object rotate, alignment and arrangement; and others.

Some of these buttons contain a little triangle on one side. Keeping these buttons
pressed opens a menu of options for that tool. For example: filled or hollow
rectangles, sharp or round edges, etc.

Layout Templates.  Contains a gallery of the templates available. Just click on the
template you want to switch the current slide to.

Slide Navigation.  Displays a list of all the slides comprising the presentation. Slides
are displayed as miniatures, so you can see what they look like at a glance. To open a slide,
search for it in the list, then click on it.
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3.2. Adding Slides to Your Presentation

 Choose Insert  → Slide from the menu to add a new slide, after the current one,
with the currently selected slide template.

Choose Insert  → Duplicate Slide  instead if you want to base your new slide's
content on the current one.

3.3. Simple Charts

 Choose Insert  → Chart from the menu to insert a chart diagram into the current
slide. A “default” bar chart is inserted and LibreOffice Impress switches to chart mode.
Click “outside” the chart area to return to the slide design mode.

You can drag the border handles to adjust the chart's size. Double click on the drawn chart,
then right-click on it and select Chart Data Table  to enter the data according to the chart
you want to build (see Figure 2.6, “Entering Chart Data” [24]).

Figure 2.6. Entering Chart Data

Once you have entered the chart's data, close the data entry window and click on the page
to update the chart in the slide.
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Repeat the double-click / right-click sequence to change the chart's title, legends, axis, type
( 2D or 3D, bar, pie, points, lines, etc.), selecting the appropriate entries from the pop-
up menu.

3.4. Slide Background

Use the Format  → Page menu and click the Background tab to define colors, gradients,
patterns, or bitmapped backgrounds for the slide. Each background type has options of its
own. Feel free to explore them.

Using bitmaps for backgrounds increases the file's size considerably. This could
lead to a performance hit, especially on older systems.

Once the background is selected, you can make that background the default one for all
slides. Make your choice and the slide(s) background(s) will be changed.

3.5. Transitions, Animations and Effects

The Slide Show menu has slide transitions, animations and effects options and wizards
which let you add “dynamism” to your presentations. However, you should try not to
overuse transitions, animations and effects because they can be distracting to your audi-
ence, turning their attention to the effects themselves instead of the content of your pre-
sentation.

3.6. Running Your Presentation

Choose Slide Show → Slide Show, or press the F5 key to run your presentation. The
presentation then takes up the entire screen. Press the Esc key to stop the presentation.

4. Going Further

Tutorials.  The tutorials available at the Tutorials for LibreOffice [http://
www.tutorialsforopenoffice.org] Web site are helpful if you want to learn more
about the use of LibreOffice suite's major components. Check the tutorials
for Writer [http://www.tutorialsforopenoffice.org/category_index/wordprocessing.html],
Calc [http://www.tutorialsforopenoffice.org/category_index/spreadsheet.html], and Im-
press [http://www.tutorialsforopenoffice.org/category_index/presentation.html].

User Guides.  The official documentation [http://wiki.services.openoffice.org/wiki/
Documentation/OOoAuthors_User_Manual] is available online.

http://www.tutorialsforopenoffice.org
http://www.tutorialsforopenoffice.org
http://www.tutorialsforopenoffice.org
http://www.tutorialsforopenoffice.org/category_index/wordprocessing.html
http://www.tutorialsforopenoffice.org/category_index/wordprocessing.html
http://www.tutorialsforopenoffice.org/category_index/spreadsheet.html
http://www.tutorialsforopenoffice.org/category_index/spreadsheet.html
http://www.tutorialsforopenoffice.org/category_index/presentation.html
http://www.tutorialsforopenoffice.org/category_index/presentation.html
http://www.tutorialsforopenoffice.org/category_index/presentation.html
http://wiki.services.openoffice.org/wiki/Documentation/OOoAuthors_User_Manual
http://wiki.services.openoffice.org/wiki/Documentation/OOoAuthors_User_Manual
http://wiki.services.openoffice.org/wiki/Documentation/OOoAuthors_User_Manual
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Inline Help.   You can also use the inline help which is accessible through the

Help → LibreOffice Help  menu, or by pressing the F1 key. You are bound to find the
answers to your questions.



Part II. Configuring and
Tweaking Your Box
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Chapter 3. Introduction to the
Mandriva Linux Control Center

1. MCC's Components

  The Mandriva Linux Control Center (MCC) allows the system administrator to configure
the hardware and the services used by all users in a friendly way.

 Access the Mandriva Linux Control Center through the main menu ( Applications

→ Tools → Configure Your Computer ). As with all system configuration tools under
Linux, you must provide the system administrator's password.

Text Mode Configuration

Some of the Mandriva Linux Control Center components are also available from
the command line in text mode by running   drakconf.
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Figure 3.1. The Network Sharing Section of the Control Center

Here are some of the available menu entries:

• Options  → Display Logs .  When activated this option displays a Mandriva Linux
Tools Logs window. It shows all system modifications made by the configuration tools
launched from within Mandriva Linux Control Center.

• Help → Help.  Opens the help browser which displays documentation about the
active configuration tool.

• Help  → Release Notes  and Help  → Errata .  Opens the web browser and dis-
plays the release notes and errata for your Mandriva Linux system. Here you may find
tips for solving issues with certain hardware.

• Help  → Report Bug .  Allows you to report a bug to the development team. See
Section 2, “Raise an Issue” [32].
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The tools are sorted into categories. The following table lists them all and refers to the
corresponding sections of this manual.

Table 3.1. Overview of Graphical Tools

Software Management Chapter 4, Package Management [35]

Hardware Section 2, “Configuring Your Hardware” [49]

 Section 1, “Sound System Configuration” [47]

 Section 3, “Controlling the Graphical Configura-
tion” [51]

 Section 4, “Changing Your Keyboard Layout” [56]

 Section 5, “Changing Your Mouse” [57]

 Section 6, “Configuring Printers” [58]

 Section 7, “Installing and Sharing Scanners” [67]

 Section 8, “Setting up your UPS” [71]

Network & Internet Section 2, “Network and Internet Connection Manage-
ment” [75]

 Section 3, “Proxies Configuration” [85]

 Section 4, “Sharing an Internet Connection” [86]

 Section 6, “Activating and Managing Network Pro-
files” [93]

 Section 7, “Configure VPN Connections” [95]

 Section 8, “Manage Hosts Definitions” [95]

System Section 1, “Users Authentication” [101]

 Section 2, “Configuring Start-Up Services” [102]

 Section 3, “Managing Fonts on your System with Drak-
Font” [103]

 Section 4, “Setting your Machine's Date and
Time” [105]

 Section 5, “System Localization” [107]

 Section 6, “Monitoring System Activity” [108]

 Section 7, “Access to the Console” [113]
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 Section 8, “Managing Users and Groups” [114]

 Section 9, “Import Windows® Settings and Docu-
ments” [118]

 Section 10, “System Snapshots” [122]

Network Sharing Section 1, “Importing Remote SMB Directories” [127]

 Section 2, “Samba Shares Managements” [128]

 Section 3, “Importing Remote NFS Directories” [137]

 Section 4, “Share Drives and Directories using
NFS” [138]

 Section 5, “Setting up WebDAV Mount Points” [139].

Local Disks Section 1, “Managing your Hard Drive Partitions with
DiskDrake” [143]

 Section 2, “Managing Removable Devices” [148]

 Section 3, “Allowing Users to Share Folders” [150]

Security Section 1, “Setting up Rights Delegation” [153]

 Section 2, “Securing your Internet Access via DrakFire-
wall” [154]

 Section 3, “Network Interface and Firewall
Failover” [158]

 Section 4, “Parental Controls” [160]

Boot Section 1, “Configuring the Login Mode” [165]

 Section 2, “Changing your Boot-up Configura-
tion” [166]

 Section 3, “Display Manager Setup” [168]

Some other categories and tools appear if the drakwizard package is installed.
The documentation for those server wizards is available in the Server Adminis-
tration Guide. Those wizards enable you to do basic configuration of common
LAN services such as web, FTP, mail and database servers.

2. Raise an Issue
   If you encounter unexpected behavior in Mandriva Linux-specific tools, Drakbug allows
you to report it to the development team.
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To be able to report bugs using Drakbug, you need a working Internet connec-
tion as well as a  Drakbug account [http://qa.mandriva.com/createaccount.cgi].

To run Drakbug, go to the Help → Report Bug  menu entry of the faulty tool, or run it
from Mandriva Linux Control Center's own menu. A crashed Mandriva Linux tool may
also trigger Drakbug.

Figure 3.2. Reporting a Bug

1. In order to correctly report a bug, it is important to identify the package it is related
to. You can Select Mandriva Tool  or enter the application name in the Application
Name (or Full Path)  field and then click on the Find Package  button.

2. Click on the Report  button. Your web browser will then open. If you are not logged
in to the Mandriva Bugzilla web site [http://qa.mandriva.com/] you will be asked to
log in. Once you are logged on the site, complete the bug report as completely and
accurately as possible and click on Commit .

http://qa.mandriva.com/createaccount.cgi
http://qa.mandriva.com/createaccount.cgi
http://qa.mandriva.com/
http://qa.mandriva.com/
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Chapter 4. Package Management
To begin with, a bit of vocabulary.

Package
Software needs to be broken down into different files to ease development and man-
agement. An application ends up being lots of pieces: the binaries, the documentation
and the resources the application needs (images, icons, translations, sounds, etc.). A
package is the set of all of an application's components, stored in a single file in a way
that's very simple to install, update and remove.

Dependency
Applications rely on software libraries or components made by different developers to
perform a given set of functions, not part of the main function but needed to achieve it.
A dependency is a package another package needs in order to work properly. Mandriva
Linux's package management tool takes care of all these dependencies automatically.

Update
Software is a living thing: new features are added, existing features are enhanced and
problems (bugs) are fixed. An update is a package which brings in some or all of these
enhancements or fixes into an existing application. It is recommended that you check
for updates often in order to keep your system in good shape and free from bugs and
security threats.

Source
A source is a repository of packages, and the place where packages are installed from.
Sources for the media used during system installation are automatically created, you
can add your own sources for updates and packages you find on the Internet.

Media
The place where (software) packages are stored physically, be it CDs, DVDs, or an
FTP server.

Repository
Centralized place containing media (and thus, packages).

Mandriva Linux uses the RPM packaging system.    Mandriva Linux provides con-
venient tools to simplify package maintenance. The Urpmi set of tools is command line
based; here we will concentrate on Rpmdrake, Mandriva Linux's graphical software in-
stallation tool and the Software Media Manager. Figure 4.1, “Software Management in
the Mandriva Linux Control Center” [36] shows the Software Management section
of Mandriva Linux Control Center.
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Figure 4.1. Software Management in the Mandriva Linux Control Center

 Rpmdrake can be used to install or remove software  (explained in Section 1, “Adding

and Removing Software” [36]) or to update existing software  (explained in Sec-
tion 2, “Updating Packages” [40]). Media management is covered in Section 3, “The
Software Media Manager” [41].

1. Adding and Removing Software

Adding Media at First Launch

When you launch this tool for the first time, if no installation media are config-
ured already, you are prompted to add new official installation media. That will
give you access, over the Internet, to many more packages than those that could
fit in your CD or DVD. Add them if you have a fast Internet link.
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1.1. Meet Rpmdrake

When launching Rpmdrake you have to wait a few seconds while the package databases
are scanned. Then you are presented with Rpmdrake's main interface.

P a c k a g e
De t a ils

Ca t e g o r ie s
Tr e e

P a c k a g e
S e a r c h

P a c k a g e
S e t

P a c k a g e
Lis t

Figure 4.2. Rpmdrake Interface

Package Set.  Use the first pulldown list to select the types of package to be displayed:
applications having a graphical user interface (Packages with GUI, the default); Meta
packages (which are packages containing other packages, and whose names start with
task: for example task-c-devel, for all packages required for C development); a few
options for updated packages (All updates , Security updates , Bugfixes updates , General
updates); Backports  containing software adapted from other releases of Mandriva Linux;
or simply All packages. Use the second pulldown list to filter which packages to display:
All of them (installed or not); only Installed ones (to be uninstalled); or only Not installed
ones (to be installed). Each time a package set is selected, the Categories Tree is rebuilt
to display matching packages.



Handling Dependencies

38

Package Search.  Use this facility to search for a package name, description, summary,
or content (the files it provides). Type the string to be searched for, select the criterion
using the binocular, and press Enter .

Categories Tree.  To ease management, packages are classified into categories (Net-
working, Office, Games, Development, Graphics, etc.). Open a category to display pack-
ages which match the current criteria set using Package Set and Package Search.

Package List.  Where currently matching packages (Set, Category and Search Criteria)
are displayed. This is where you select packages to take action on them.

Package Details.  Displays details about the currently selected package in the Package
List.

Procedure 4.1. Performing Actions on Packages

1. Use the Package Set pulldown lists, the Categories Tree and, optionally, the Package
Search facility to browse for packages to be installed or removed.

2. In the Package List, select packages by checking their corresponding box. If the
checkbox by the package name is empty, it means that the package can be installed,

once selected it will be marked with the icon. If the package is marked with the

 icon, it means the package is already installed, uncheck its box to select it for

removal and it will be marked with the icon.

You may notice that some packages are marked with a “do not enter” 
icon. These are “base” packages which cannot be removed because one
would end up with a broken system, their checkboxes cannot be unselected.

3. Once you are satisfied with your choices, click on Apply  to perform the actual in-
stallation or removal of packages. You are shown how many bytes will be transferred
and how much disk space will be needed (or regained) and asked for confirmation,
then a new window appears, where you can see the progress of the actions being tak-
en. If you prefer to leave without doing anything, you can click on Quit.

1.2. Handling Dependencies

It may happen that you select a package which requires dependencies (additional libraries
or other tools) or which is a dependency of other packages. In this case Rpmdrake displays
an information window allowing you to choose whether to accept the selected dependen-
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cies, to Cancel  the operation, or to get More info  on the operation (see Figure 4.3, “De-
pendency Alert Box” [39]). It also shows how much disk space will be used.

Figure 4.3. Dependency Alert Box

Alternative Dependencies.  You may also want to install a package which requires
dependencies, and various packages which are capable of providing that dependency. The
list of alternatives is then presented (see Figure 4.4, “Alternative Packages” [39]). You
may read the additional information presented by clicking the Info...  button to help you
choose the best alternative.

Figure 4.4. Alternative Packages
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2. Updating Packages

 Updated packages are available through notifications. Once update media is con-

figured, the Mandriva Update  icon shows on the panel when updates are available.
Just click on it to check the packages to be updated and update them.

Adding Update Media.  The first time you launch this tool, you are prompted to add
update media. Follow the instructions to do so.

Figure 4.5. Updating Packages

1. By default, all updates are selected for installation, you should review the list. This
simple interface allows you to quickly check for available updates and to install them
with one click.

2. Click Update  to download and install all selected updated packages.
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3. The Software Media Manager

 Use this tool to configure the package media repositories. Figure 4.6, “Configured
Software Media” [41] shows some media already defined: “Main”, “Contrib”, etc.
You can also add other software media: a CD from a magazine containing RPMs, a Web
repository, etc.

Figure 4.6. Configured Software Media

Depending on how you installed your system, the media list might be empty.
To fill it with standard package sources, use the Add button.
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Use the check boxes in the left-hand columns to flag the repositories

Enabled
Uncheck this box to temporarily disable the corresponding medium. The packages
contained in this medium will not be available until you enable the medium again.

Updates
This box is checked for update media, that is, media that contains updates of packages
that are already in another medium, albeit with an older version number. Thus only
selected update media are taken into account when looking for updates.

To avoid headaches because of wrong media marked as update media, you
cannot change whether a medium is considered as an update medium or
not. If you really must set a medium as an update medium, and you really
know what you are doing, you can run drakrpm-edit-media --expert from
the console and the Updates  column will be enabled again. Use at your
own risk.

Action Buttons on the Right

Remove
Discard a medium which you no longer use. Simply select (highlight) the medium to
be removed and click the Remove  button.

Edit
Change the medium's parameters: the URL or the downloader (if you do not know
what we are talking about, it is wise to leave this window via Cancel  instead of Save
changes).

 If you need to pass through a specific proxy to access this particular medium, you
can configure it here by clicking on Proxy.

Add
Add to your system all publicly available official package sources from Internet repos-
itories. This is useful for example if you have a fast Internet connection or only have
the first installation CD at hand.

After choosing a mirror and clicking OK, package information for the source you
have chosen is downloaded and all included packages will be available.

Up and Down arrows
These buttons allow you to change the order in which sources will be used when
installing packages. By default, the newest version of a given package will always be
installed, but if the same version is found on two different media, the one from the
first medium in the list will be installed.
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Therefore, it is better to move fastest media further up the list

Actions Available From the Menu

File  → Update
You are shown a list of all enabled media; select those you want to update the list of
available packages for, and click Update . This is useful for remote media to which
new packages are being added. Keyboard shortcut: Ctrl+ U.

File  → Add a specific Media Mirror
While the Add button lets the system choose a mirror best suited for you, this menu
entry allows you to choose another one. You should choose a mirror geographically
near to your location.

File  → Add a custom medium
Choose this to open a new dialog, in which you define all the required parameters for a
new software package medium. Please bear in mind that the parameters, and available
options, depend on the type of medium being defined. Keyboard shortcut: Ctrl+ A.

Figure 4.7. Adding a Custom Package Repository Medium

Options  → Global options
Allows you to configure the program used to retrieve remote packages, whether the
packages should be checked against a key and also to set the package information
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download policy (on-demand - the default, always, update-only, or never - useful for
slow network connections or if you are charged per bytes transferred). These choices
affect all package sources. Keyboard shortcut: Ctrl+ G.

Options  → Manage keys
It is important that any package you install is authenticated. To do so, each package
can be electronically signed with a “key”, and you can allow/disallow keys on a per-
medium basis. In ???, you can see that the Mandriva Linux key is allowed for medium
“Main”. Click on Add to allow another key for the selected medium (beware, do this
with care, as with all security-related questions), and on Remove  to remove a key
from the selected medium. Keyboard shortcut: Ctrl+ K.

Options  → Parallel
If you are running a large network of computers, you may want to install a package
on all the computers in parallel; choosing this menu opens a dialog window allowing
the configuration of the “Parallel” mode. As it is rather complicated and only useful
to a limited group of people, this short introduction will not give further details about
it. Keyboard shortcut: Ctrl+ P.

Options  → Proxy
If you are blocked by a firewall and you still need to access remote media (especially
for package updates), you can do so if you have a proxy server which leads to the
Internet (at least in an area where you can find a package server). Normally it should
be enough to fill in the Proxy hostname to get it working (see Figure 4.8, “Specifying
a Proxy for Remote Media” [45]). If you need a user / password combination to get
through the proxy, you can also specify these here. Adjust your settings and confirm
your changes by clicking on OK and you are done. Keyboard shortcut: Ctrl+ R.
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Figure 4.8. Specifying a Proxy for Remote Media
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Chapter 5. Hardware Setup

1. Sound System Configuration

 This tool allows you to configure your sound card which can be necessary
if you experience sound problems (no sound, etc.) or if the sound card you use is not the
same as at installation time. You can find it in the Hardware section of the Mandriva Linux
Control Center.

Figure 5.1. Sound Configuration Main Window
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1.1. Changing Drivers

You can switch from one driver to another by selecting it from the Driver  drop-down list.
All the drivers compatible with your sound card are displayed: you have to choose between
the OSS or the ALSA API.

We recommend that you use ALSA because OSS is a very basic and limited
API. If your sound card is very old you may need to use OSS. On the other hand
ALSA is a more elaborate and much richer API than OSS and provides many
enhanced features.

You can read more detail on this subject by clicking on the Help button.

If you are an expert you can access the full list of drivers and choose another one by clicking
on Advanced  and then on Let me pick any driver .

1.2. Other Sound Options

You can configure other options for PulseAudio, the sound server. by checking the corre-
sponding boxes.

Enable PulseAudio
Activates the sound server. PulseAudio accepts sound input from many sources and
mixes them together enabling sound output on the desktop. It is compatible with most
audio sources. PulseAudio is the default sound server, it is recommended you leave
it enabled.

Enable 5.1 sound with PulseAudio
Check this option if you have a multichannel audio system and want to take advantage
of all its features.

Enable user switching for audio applications
When a user logs in they monopolize the sound hardware: if another user logs in, their
programs won't have any sound. If your machine hosts several users, check this option
to enable sharing the sound hardware among logged in users. Even if a user is logged in
and has locked the session, other users can login and have the sound available for their
programs. It is recommended that you leave this option checked. You may uncheck
it in specific cases when you want the first logged in user to have exclusive access
to the sound hardware.

Click on Advanced  to access more options. Here you can choose another driver, reset the
sound options to their defaults or find a troubleshooting procedure.
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2. Configuring Your Hardware

2.1. Hardware Detection and Configuration

Abstract

    The HardDrake project simplifies hardware detection and configuration
under Linux by providing a user-friendly interface.

HardDrake detects and configures existing hardware at boot time automating and simpli-
fying the process of installing new hardware. When launched from the Mandriva Con-
trol Center, HardDrake displays information about your system's hardware and can launch
configuration tools to modify hardware or driver settings.

HardDrake uses the “ldetect” engine, so if your new hardware is not detected, you may
try to upgrade the ldetect library itself and its hardware database, located in the lde-
tect-lst package.

2.1.1. Using HardDrake

After all devices have been detected, the main HardDrake window appears (see Figure 5.2,
“Selected Device” [50]). On the left is the device tree that shows all the hardware
categories.
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Figure 5.2. Selected Device

By selecting a device, you see additional information about it in the right frame. To bet-
ter understand the meaning of the information presented, you can consult the help page

accessible by choosing Help → Fields description  from the menu.

Depending on the device selected, other buttons may appear:

• Set current driver options .  This pops up a window with all the module device
parameters listed. For experts only!

• Run config tool .  Launches the Mandriva Linux configuration tool (available
through Mandriva Linux Control Center) associated with that device. For sound cards,
a special configuration tool is used which allows you to select the sound card's driver
and provides some troubleshooting tips.

Unknown hardware.   A special category called Unknown/Others may also show
up, containing all the unknown hardware in your system, as well as known hardware which
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does not fit into any existing categories (such as thermal sensors, random number gener-
ators, etc.).

Auto-detection of special devices.  You can also toggle the entries in the Options
menu to enable automatic detection of some hardware which wouldn't have been detected
otherwise. You need to restart HardDrake for this change to take effect.

2.2. Problems and Troubleshooting

  If you think you have found a bug related to HardDrake, report it using the Mandriva
Linux bug reporting tool (see Section 2, “Raise an Issue” [32]).

Sound Cards.  HardDrake does not probe for ISA PnP devices. If you have an ISA PnP
sound card, run sndconfig or alsaconf from the command line. You may need to install
the sndconfig or alsa-utils package.

3. Controlling the Graphical Configuration

This tool allows you to configure your graphical display. With it, you can change
your video card, your resolution and your monitor. It can be useful if you change one of
your graphical components after the initial installation.

If you don't see a graphical login at boot

If the graphical server cannot start because of a configuration error, a dialog
offers to reconfigure the graphical server. You get a tool similar to the one de-
scribed here, but in text mode.
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3.1. XFdrake Interface

Figure 5.3. XFdrake Main Window

The buttons allow you to change aspects of the graphical configuration:

Graphic Card
The button displays the name of the graphic card currently configured. Click on it if
you want to change it. Depending on your card, different servers may be available,
with or without 3D acceleration. You may need to try different ones until you get the
best result.

You may be asked if you want to use a proprietary driver for your card,
answer Yes to use the driver provided by the card's manufacturer. This
driver may give you access to more features and also make your card per-
form better on 3D applications, such as games.

If you cannot find the graphic card you have, but you know which driver supports it,
select it from the Xorg entry at the bottom.
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Monitor
Allows you to change the monitor with the tool described in Section 3.2, “Changing
the Monitor” [54].

Resolution
Enables changing the pixel resolution and the color depth with the tool described in
Section 3.3, “Changing the Resolution” [55].

Other buttons are also available:

Test
Allows you to verify that your modifications actually work. It is highly recommended
that you do test it, because if it does not work, it will be harder to recover a working
graphical environment later. If the test fails, simply wait until it ends. If you are not
satisfied with the suggested settings, choose No during the test, and you will return
to XFdrake's main window.

If the test is not available

Depending on your video card, video testing may not be available. You will
be warned of such a situation. If it happens that the settings are incorrect
and your display does not work, type XFdrake as root in the console to
use XFdrake's text version.

Options

Global options
By default, restarting X server using Ctrl+Alt+Backspace keys is disabled. You
can reenable it unchecking this option.

Graphic card options
Depending on your hardware capabilities, you can choose to enable or disable
specific features such as hardware acceleration or special visual effects (translu-
cency).

Graphical interface at startup
Use this option to choose whether you want your machine to automatically switch
to a graphical interface at boot. Obviously, you may want to disable this option
if your machine is to act as a server, or if you were not successful in getting the
display configured.

Quit
If you modify your graphical display in some way, the current configuration is dis-
played and XFdrake asks you whether you want to keep your changes. This is your
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last chance to go back to the old configuration. If all seems OK, click on Yes. If you
want to restore the previous parameters, click on No.

Confirm the changes and restart your graphical environment to activate the new configu-
ration.

3.2. Changing the Monitor
Monitor models are listed in XFdrake's window (see Figure 5.4, “Choosing a New Moni-
tor” [54]). If your monitor was automatically detected, it is listed as Plug'n Play along
with its model.

Figure 5.4. Choosing a New Monitor

If your monitor wasn't automatically detected, you can choose it from the list, from the
Vendor entry. If you don't find your monitor or a compatible one, choose one with param-
eters corresponding to the monitor from the Generic  entry, at the bottom.
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3.3. Changing the Resolution

Simply choose the resolution (800x600, 1024x768, 1152x864, etc.) and the color
depth (16 million colors (24 bits), 65 thousand colors (16 bits),
etc.) you want from the lists.

Figure 5.5. Changing the Resolution of Your Screen

The monitor in the window displays what the desktop will look like with the chosen con-
figuration (see Figure 5.5, “Changing the Resolution of Your Screen” [55]). If it looks
good, click OK. Depending on the resolution you've chosen you may need to logout and
restart your graphical environment for the settings to take effect.

Monitor and Resolution Ratio.  By default, the available resolution list only shows
resolutions supported by your video card and monitor combination. There is a special entry
named Other  that adds more possible resolutions along with their ratios. Bear in mind that
most monitors are designed with a 4:3 horizontal vs. vertical ratio.
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4. Changing Your Keyboard Layout

Abstract

  This tool allows you to define another keyboard layout, which is useful
when the keyboard you want to use is different to the one chosen at installation time.

Figure 5.6. Choosing a Different Keyboard Layout

Select your keyboard's layout (which is closely associated to the language you speak) and
then its type (or model) from the lists shown in Figure 5.6, “Choosing a Different Key-
board Layout” [56]. If you own a multimedia keyboard and it is listed in the list of
manufacturers, chances are that most multimedia keys on it will be supported. Otherwise,
choose your keyboard type under the Generic  branch. Changes are effective immediately
after clicking OK.
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If you choose a keyboard layout based on a non-Latin alphabet, you are asked to
choose the key combination that will switch the keyboard configuration between
the Latin and non-Latin layouts.

5. Changing Your Mouse

  This tool enables you to set up a different mouse, which is useful if the mouse
you are currently using is not the same as the one you chose at installation time.

The “Synaptics Touchpad” function is automatically configured to work with
almost every touch pad found on notebook computers. The same goes for Wa-
com®  tablets.

Figure 5.7. Choosing a Different Mouse
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Mice are sorted into a tree according to their connection type and model (see Figure 5.7,
“Choosing a Different Mouse” [57]). Highlight the mouse of your choice and click
OK. Changes take effect immediately after the mouse test is done.

The Any PS/2 & USB mice option works with virtually all modern mice.

If you have a mouse with more than 5 buttons, and it's not automatically config-
ured, select the Force evdev option and use the assistance provided to configure
the non-working buttons.

6. Configuring Printers

This tool allows you to configure printers, both connected directly to your sys-
tem, and remote printers served by other systems. You can find this tool in the Hardware
section of the Mandriva Control Center.

It is possible that you will be asked to install software packages when you run
the tool for the first time, please accept these package installations.

6.1. Automatic Installation

The system will automatically configure any new printer you connect to the USB port of
your computer. When that happens you get a notification on the panel stating the printer
is configured and ready to print.

Check the configuration.  Once the printer is automatically installed, you should how-
ever check and tune its configuration: Section 6, “Configuring Printers” [58].

6.2. Manually Adding a Printer

Procedure 5.1. Local Printer

1. Connect the printer to your system.

2. Choose Server+ New → Printer  from the menu. If the printer was detected auto-
matically, it's offered as the 1st option in the Devices  list (see Figure 5.8, “Automat-
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ically Detected Printer” [59]), otherwise you can select the port and driver man-
ually: make sure you have all needed data at hand. Keyboard shortcut: Ctrl+ N.

Figure 5.8. Automatically Detected Printer

3. Select the printer driver. If the printer was autodetected (as is the case with USB
printers), just accept the suggested settings and click Forward . You can also provide
your own PPD file or search for a suitable driver on the Internet. If there is more than
one driver available for your printer, you are asked to choose which one to use: it
is advisable that you keep the recommended one (see Figure 5.9, “Choosing Printer
Driver” [60]).
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Figure 5.9. Choosing Printer Driver

4. Provide descriptions for the printer. These serve to better identify printers if you
happen to have more than one configured (see Figure 5.10, “Printer Descrip-
tion” [61]). Fill the Printer Name, Description, and Location fields as you see fit.
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Figure 5.10. Printer Description

5. Click on Apply , the printer is then listed and marked as ready and available (see
Figure 5.11, “Available Printers” [62]).
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Figure 5.11. Available Printers

Procedure 5.2. Remote Printer

1. Ask your system or network administrator for the model and name of the printer and
the protocol it uses. Make sure the printer is turned on.

2. Choose Server+ New → Printer  from the menu and choose the communications
protocol in the Devices  list using the information provided by your system or network
administrator. The example shows a printer served by a Windows system (see Fig-
ure 5.12, “Windows System Printer Setup” [63]). Keyboard shortcut: Ctrl+ N.
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Figure 5.12. Windows System Printer Setup

3. The rest of the steps are the same as described for the Local Printer configuration:
choose the driver, fill in the descriptions, and click Apply  to make the remote printer
available to print on your system.

6.3. Changing Printer Configuration

Double click on a printer to access its properties. Open the section you are interested in,
make your selections and click Apply  to make your settings effective immediately.
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6.3.1. General Settings

Allows you to change the printer descriptions and driver. It also provides buttons to print
test pages and clean print heads (if applicable).

6.3.2. Policies
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Allows you to change whether the printer is enabled, if it's accepting jobs, if it's shareable,
what to do when printing errors occur, etc.

6.3.3. Access Control

By default, all users can print on the system printers, if you want to limit the users that can
or cannot print on your system, fill the field and click the Add button to add user names
to the Users list and then choose the following:

• Allow printing for everyone except these users  to deny printing to the listed users

• Deny printing for everyone except these users  to allow printing only to the listed users.

The example shows that only users peter and queen can print.



Changing Printer Configuration

66

6.3.4. Printer Options

Allows you to change the default paper size, printout mode and quality settings.

6.3.5. Job Options
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Allows you to change various print job parameters, such as the number of copies, scaling,
orientation, etc.

7. Installing and Sharing Scanners

   The ScannerDrake wizard helps you install your scanner. Make sure your
scanner is powered on and launch ScannerDrake by clicking on the Scanners  entry of the
Mandriva Linux Control Center's Hardware section.

Please note that not all scanners are supported under Linux. Before buying
new hardware, remember to check out Mandriva's Hardware Database [http://
hcl.mandriva.com] and the SANE home page [http://www.sane-project.org/] for
compatibility issues.

7.1. Main Interface and Scanner Installation

The program tries to detect the manufacturer and model of your scanner. If it finds the
scanner then information about it is displayed in the upper part of the wizard's main win-
dow. The window also offers a few action buttons (Figure 5.13, “Installing your Scan-
ner” [68]).

http://hcl.mandriva.com
http://hcl.mandriva.com
http://hcl.mandriva.com
http://www.sane-project.org/
http://www.sane-project.org/
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Figure 5.13. Installing your Scanner

Search for new scanners
Click on this button to autodetect a new scanner you have just plugged in.

Add a scanner manually
Use this button if the automatic detection fails and then look for the specific model
you own by browsing through the list of available scanners and models.
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Figure 5.14. The Tree-list of All Known Scanner Models

Choose the correct Port.  After choosing the appropriate model, you can leave the
default Auto-detect available ports  option unless you have a parallel port scanner, in which
case selecting /dev/parport0 in the pull-down list should be the right choice.

HP multi-function devices

Note that HP multi-function devices, such as the OfficeJet and PSC printers,
must be configured through the printer configuration tool described in to Sec-
tion 6, “Configuring Printers” [58]. The scanning part of non-HP mul-
ti-function devices can be set up with ScannerDrake as a stand-alone scanner.

Test the Scanner.  Once your scanner appears in ScannerDrake main window, you can
test its configuration by using any scanning application such as Kooka or The Gimp.
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7.2. Share your Scanner

ScannerDrake allows for scanner sharing between users connected via a LAN.

Figure 5.15. Sharing Scanners within a LAN

Procedure 5.3. Share Your Own Scanner

1. Check the The scanners on this machine are available to other computers  box.

2. Click the Scanner sharing to hosts  button and then Add host to specify which hosts
will be actually allowed to access your scanner.

Procedure 5.4. Use Other People's Scanners

1. Check the Use scanners on remote computers  box.

2. Click the Use the scanners on hosts  button and then Add host to specify which
hosts serve the scanner you wish to use.
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8. Setting up your UPS

 This tool will configure the NUT (Network UPS Tool) service for you. The service
checks the UPS connected to your machine and automatically shuts it down when the UPS
is about to run out of battery power.

Automatic Installation.  Select the Connected through a serial port or a USB cable
option to let DrakUPS autodetect your UPS.

Procedure 5.5. Manual Configuration (Serial Port)

1. Select the Manual configuration option.

2. Select your UPS from the list of manufacturers and models.

3. Then assign a Name, Driver , and Port1.
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If all went well your UPS should now be configured and ready to help avoid power outage
surprises.
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Chapter 6. Setting up your
Network and Accessing the Web

1. Network Manager

 The network manager is an applet that allows to configure the way your computer
accesses the Internet. Just click this icon on the panel to show the available interfaces.

Figure 6.1. Display Available Interfaces

Available actions in the Network Manager popup

Disable the entire networking
Untick the Enable networking box in order to completely disconnect your computer.

Disconnect a single interface
By unticking the box next to its name

Monitor Interfaces Activity
When clicking on an interface name, a graph shows the activity on that interface.
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1.1. Create a New Connection
By clicking the Manage Connections  button, you open the configuration tool.

Figure 6.2. Configuring the Interfaces

1. Select the type of connection you wish to configure (Wired, Wireless, Mobile, VPN,
or DSL).

2. Click on Add for a new connection or Edit  to modify an existing one.

3. Fill the required information and click OK.
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2. Network and Internet Connection Management

Connections management is now handled through the KDE Network Manager
(see Section 1, “Network Manager” [73]). The Control Center tools are left
for legacy reasons, but you should not use them normally.

By default, your computer is protected by a firewall so as to avoid bad surprises
such as intrusions into your system. If you need to open some incoming ports
for other people to connect to your computer, you can use DrakFirewall. Please
refer to Section 2, “Securing your Internet Access via DrakFirewall” [154]
for more information.

 The drakconnect set of tools allows you to easily configure your network access, whether
it be to the Internet or to a local network, while the new Network Center allows you to
reconfigure and monitor your network interfaces. Open  Mandriva Linux Control Center
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and select the Network & Internet  section to access these tools. A view of the main inter-
face is shown in Figure 6.3, “Network Configuration and Monitoring Tools” [76] .
The Internet connection sharing tool is described in Section 4, “Sharing an Internet Con-
nection” [86], the proxy configuration tool is described in Section 3, “Proxies Config-
uration” [85], and the network profiles tool is described in Section 6, “Activating and
Managing Network Profiles” [93].

Figure 6.3. Network Configuration and Monitoring Tools

1We only describe the most common types. If yours is not described, you may still be able to use the methods
described here as a guide.
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2.1. Setting up a New Network Interface

 drakconnect supports different types of Internet and network connections1. The
first step consists of choosing which type of connection you want to configure. Always
make sure you have all the information provided by your ISP or network administrator
at hand.

After a connection has been configured, it may be further modified using the
Network Center  (see Section 2.2, “Network Center: Reconfiguring and Moni-
toring Network Interfaces” [82]).

2.1.1. Wired Ethernet Connection

1. Your NICs are detected automatically; if you have more than one, select the one you
want to configure. You can also load a driver for your NIC manually.

2. You now have to specify whether the network parameters are automatically set up
(Automatic IP (BOOTP/DHCP)) or not (Manual configuration): fill the next fields
with the parameters that your ISP or network administrator gave you. See our exam-
ple of manual configuration of IP parameters in Figure 6.4, “Setting Static LAN Con-
nection Parameters” [78].

3. a. If you chose the static IP configuration type, you must specify the rest of the
parameters, namely the hostname, DNS server IP address(es) and the IP address
of the machine giving you access to the Internet, known as the gateway (see
Figure 6.4, “Setting Static LAN Connection Parameters” [78]).
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Figure 6.4. Setting Static LAN Connection Parameters

b. If you configure the network with DHCP, you can optionally provide DNS serv-
er information (remove the check from the Get DNS servers from DHCP option
and fill the corresponding fields with the IP addresses or hostnames of the DNS
servers) and the machine's hostname (remove the check from the Assign host
name from DHCP address  option and fill the corresponding field with the host-
name: this is the name which will be assigned to the machine when no network
configuration has been found).

4. Allow users to manage the connection
If you want users to be able to bring up or shutdown the connection without
having to provide the administrator (root) password check this box.

Start the connection at boot
Uncheck this if you want the connection to be activated on demand only.

The Net Applet

An applet appears in the desktop's panel indicating that the connection is up 

or down . Right click on it to access a menu that also allows you to control
the connection's state, as well as other parameters.
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2.1.2. Wireless Connection

This entry allows you to configure WiFi (PCMCIA or PCI) devices.

1. If your WiFi card is not listed, insert the manufacturer's card drivers CD, then choose
the Use a Windows driver (with ndiswrapper)  entry and select the driver (it's a file
whose name ends in .inf) from the CD.

2. A list of detected networks is then shown. Select yours; otherwise, choose unlisted.

3. Operating Mode
The mode the card will operate on, with respect to the other WiFi devices in the
network. The most common one is Managed  to simply connect to an existing
access point.

Network Name (ESSID)
The name of the network you want to connect to. Ask your network administrator.

Encryption Mode
This depends on the network settings, ask your network administrator.

Encryption Key
This also depends on the network settings, ask your network administrator for
the key the network uses.

4. Remaining configuration is similar to the traditional Ethernet network setup: see Sec-
tion 2.1.1, “Wired Ethernet Connection” [77].

5. Check the Allow access point roaming box if you want the connection to automati-
cally switch from one access point to another, depending on its signal strength. This
is particularly useful when moving a laptop around.

Managing Connections.  Consult Section 5, “Managing Wireless Connections (Roam-
ing)” [90] to learn how to configure and manage various wireless networks.

2.1.3. DSL Connection

1. Choose the device your DSL modem is connected to, and click Next.

2. You then see a list of countries/ISPs. If yours is listed, select it: most of the following
parameters will be automatically set. If your ISP is not listed, select the Unlisted - edit
manually  option, click on Next and fill the parameters with the settings provided
by your ISP.

3. You have to specify the connection protocol, as advertised by your provider. The most
common protocol being DHCP, followed by PPPoE and PPPoA.
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Figure 6.5. Setting the DSL Connection Protocol

All protocol types need at least a user name and a password, fill the corresponding
fields with them. The required packages are installed.

4. You are then asked whether users can bring the connection up/down and whether or
not to bring the connection up at boot: since DSL connections are of the “always up”
type, you can safely check the Start connection at boot  option. Finally you can test
the connection: we strongly recommend you to do so, to make sure all parameters
are accurate.

2.1.4. Cable Connection

This configuration is very similar to the one described in Section 2.1.1, “Wired Ethernet
Connection” [77]. Make sure you have all required parameters provided by your ISP
at hand.

Authentication.  Some cable ISPs need you to authenticate. If this is your case, select
the Use BPALogin option. If you are unsure or don't know, it is safe to select the None
option.
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2.1.5. Analog Telephone Modem Connection (POTS)

1. A list of detected modems is shown. If no modem was detected, only the Manual
choice option is shown, click on Next and choose the communications port the mo-
dem is connected to. The required packages are installed.

2. Then you see a list of countries/ISPs. If yours is listed, select it and continue to the next
step: some parameters (connection name, phone number to dial, and authentication
scheme) will be automatically set. If not, select the Unlisted - edit manually  option.

3. Verify the parameters, add the missing ones provided by your ISP.

Figure 6.6. Entering Dial-up Connection Parameters

All parameters should be obvious, except for the authentication type. The value in the
Authentication pull-down depends on what your ISP supports: Script-based (an old
type of authentication method based on “expect” and “send” types of chat between
your system and your ISP); Terminal based (a terminal window pops up when the
connection is made and you have to login interactively); PAP, CHAP, or PAP/CHAP
(authentication information exchange protocols, CHAP is preferred because it is more
secure, PAP/CHAP will automatically choose the supported one).
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4. Then come the IP, DNS and gateway settings. Nowadays, most ISPs provide them
automatically when a connection is made, so selecting the Automatic  option on them
is usually a safe bet.

5. You are then asked whether users can bring the connection up/down and whether or
not to bring the connection up at boot: since analog modem telephone connections
are not of the “always up” type, you should not check the Start connection at boot
option. Finally you can test the connection: we strongly recommend you to do so, to
make sure all parameters are accurate.

2.2. Network Center: Reconfiguring and Monitoring Network
Interfaces

The Network Center allows you to check network interface status; modify net-
work interface-specific parameters, after you have set them up through the new interface
wizard (see Section 2.1, “Setting up a New Network Interface” [77]); and connect/dis-
connect the network interfaces.
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For each network interface the following is shown: an icon2 representing interface status

(  for Up or Connected;  for Down or Disconnected; and  for Non-configured -
typical for WiFi interfaces which are not linked to an access point); the interface hardware
name; and the interface software device, for example eth0 for the 1st Ethernet interface.

Click on the small triangle on the interface status icon to show buttons to take actions on
the corresponding interface:

Traffic Monitoring
Click on Monitor  to monitor traffic on the interface as shown in Section 2.3, “Mon-
itoring Connections” [84].

Change Configuration
Click on Configure  to change the interface configuration parameters as shown in
Section 2.4, “Reconfiguring a Network Interface” [85].

2The example shows the icons for Ethernet interfaces, the icon displayed will vary for other interface types, but
the coloring scheme is the same.



Monitoring Connections

84

Show Available Wireless Networks (if a wireless interface is selected)
Click on Refresh  to rescan for available wireless networks, and select the network
you want to connect to from the list. For more details about how to use the wireless
connections management interface, please refer to Section 5, “Managing Wireless
Connections (Roaming)” [90].

Connection Control
Simply click on Connect/ Disconnect to bring the network link up or down on that
interface.

2.3. Monitoring Connections

Figure 6.7. Real-Time Network Connection Monitoring

Network interface activity is shown for the selected interface. You can specify some op-
tions for the traffic graphic and statistics (see Figure 6.7, “Real-Time Network Connection
Monitoring” [84]). It can also be used to control the status of the network connection,
bringing it up or down using the button at the lower left.

The network monitoring interface can be brought up by users through the net
applet to monitor traffic.
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2.4. Reconfiguring a Network Interface

Figure 6.8. Changing Network Parameters

The current interface configuration is shown where you can change basic parameters such
as whether to use an automatic or manual configuration, and if set to manual then which IP
address, gateway and DNS servers to use. Click on Advanced  to access more advanced
configuration parameters, for example which DHCP client to use.

3. Proxies Configuration

If your Internet connections must (or can) pass through a proxy, this tool allows
you to define the URLs of proxies for the FTP and HTTP protocols. Figure 6.9, “Proxy
Server Settings” [86] shows example settings, just fill the fields with the required val-
ues and click Ok.
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Figure 6.9. Proxy Server Settings

What's a Proxy.  A proxy is a server that retrieves information from the Internet on your
behalf, keeping a local copy of the web pages that are most frequently requested. They are
referred to as “caching proxies”, and optimize bandwidth usage. In some organizations,
you cannot access the Internet directly. You must pass through a proxy that authenticates
you before allowing you to connect to the Internet. This is usually combined with a firewall
that only guarantees the proxy direct access to the Internet. They are referred to as “au-
thentication proxies”. In corporate or business environments, proxies perform both caching
and authentication functions for performance and security reasons.

4. Sharing an Internet Connection

 This tool configures your system so that it acts as a gateway to the Internet for
other machines connected to it via a LAN. This is very useful at home, for example, if you
want all computers to access the Internet through the same Internet link.
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Figure 6.10. A Simple Gateway Configuration

The overall procedure is as follows:

1. Configure your Internet access (Section 2, “Network and Internet Connection Man-
agement” [75]). In order for your machine to act as a gateway, you need an al-
ready configured and working connection to the Internet, plus a network connection
to your LAN. This implies at least two interfaces, for example, a modem and an Eth-
ernet card.

2. Set up the gateway (Section 4.1, “The Gateway Connection Wizard” [87]).

3. Configure the other local machines as clients (Section 4.3, “Configuring the
Clients” [89]).

This wizard also configures a firewall to block most connections from the In-
ternet. You are encouraged to check that the firewall configuration (Section 2,
“Securing your Internet Access via DrakFirewall” [154]) suits you after com-
pleting the wizard.

After you complete this wizard, all computers on the LAN will have to access the Internet.
Their configuration will be automated due to the DHCP server, which is installed on your
gateway, and the web access will be optimized through the Squid transparent proxy cache.

4.1. The Gateway Connection Wizard
These are the steps the wizard takes:

In order to successfully complete the wizard, some steps require software pack-
ages to be installed. Please accept installation of those packages.
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1. You first need to specify the name of the interface connected to the Internet. The
wizard may automatically select it for you, otherwise make sure you select the correct
one from the drop-down list. It should be the interface name you configured in the
Internet Configuration Management tool.

2. If you have more than one Ethernet interface, and depending on what you chose as
your Internet interface, the wizard might ask you to select the one connected to your
LAN3. Make sure you select the correct one.

3.

Figure 6.11. Configuring the LAN

At this point, if it is the 1st time the system has been configured as a gateway, the
wizard offers default parameters for the new local network to be managed. Check that
these values are not already in use in your network, and proceed to the next step.

Otherwise, the wizard will first offer to reconfigure the LAN interface so that it will
be compatible with the gateway services. It is recommended that you leave the default
options and click on Next.

4. If you plan on having a local name server on your machine, you can check this box.
Otherwise, you can choose to use your provider's name server. If you don't know what
a name server is, leaving the box checked is safe.
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5. Installing a DHCP server on your machine allows all client machines to have their
network configurations made automatically. Otherwise, you have to configure each
client by hand: IP address, network, gateway, DNS.

6. A caching server records the Web pages requested by local browsers. Then, if the
same page is asked for again by someone else, it is able to serve it without needing to
retrieve it again from the Internet, therefore saving bandwidth and improving response
time. This is very useful if there are many clients behind the gateway.

The application used to perform this task is  Squid [http://www.squid-cache.org/].

7. This step shows if your local machine (the gateway) has access to printers.

Choose Yes if you want the client machines connected to the gateway to be able to
access the printers accessible from the gateway itself.

4.2. Disable Connection Sharing

If you wish later to disable the gateway, relaunch the wizard. You will be asked whether
you want to reconfigure or disable connection sharing.

4.3. Configuring the Clients

 The configuration of the clients depends mainly on whether you chose to install a DHCP
server on your gateway or not. By configuring the clients on the local network to use
DHCP, they will automatically use the Mandriva Linux machine as a gateway to the In-
ternet. This works for Windows ®, Linux and any other OS that supports DHCP.

If you have no DHCP server, you have to configure each of your machines manually,
according to the network parameters set on the connection sharing wizard.

Configuring your Mandriva System.  For DHCP, on a Mandriva Linux client sys-
tem, simply go to the Network Center (Section 2.2, “Network Center: Reconfiguring and
Monitoring Network Interfaces” [82]) and make sure you select options Automatic
IP (BOOTP/DHCP) and Get DNS servers from DHCP when configuring the network, as
shown in Figure 6.12, “Configuring a Client to Use DHCP” [90].

http://www.squid-cache.org/
http://www.squid-cache.org/
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Figure 6.12. Configuring a Client to Use DHCP

5. Managing Wireless Connections (Roaming)

How to Use this Tool

 This tool is embedded into the Network Center (Section 2.2, “Network
Center: Reconfiguring and Monitoring Network Interfaces” [82]). You can
also right click on the “signal meter” icon in the panel and choose Wireless
networks + Manage wireless networks . Then enter the system administrator's
password to access the tool.

This tool shows the wireless networks currently available. It also allows you to
switch between the networks and to change their configurations. If you haven't configured
your wireless interface yet, please refer to Section 2.1.2, “Wireless Connection” [79].
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Figure 6.13, “DrakRoam's Interface” [91] shows DrakRoam's interface: a list of the
available networks, together with their status, and buttons for actions at the bottom.

Figure 6.13. DrakRoam's Interface

The list of detected networks is shown. If you expect to see other networks, click Refresh .

5.1. Switching Networks
To change networks, select one from the list, then click on Connect . If the network is
public, you are immediately connected. If it's private, you are asked for configuration pa-
rameters with the same dialog shown in Figure 6.14, “Changing Wireless Network Con-
figuration” [92]. Provide the required settings (in particular, the encryption key) and
click OK. Settings take effect immediately.

5.2. Configuring a Wireless Connection
If you need to change the network parameters, select the network from the list, then click
on Configure . See Figure 6.14, “Changing Wireless Network Configuration” [92] for
an example of a secure wireless network connection.
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Figure 6.14. Changing Wireless Network Configuration

Make your adjustments and click OK; the settings take effect immediately. Click on Ad-
vanced to fine tune parameters such as network ID and frequency.
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6. Activating and Managing Network Profiles

Mandriva Linux Control Center netprofiles application enables you to store dif-
ferent configuration sets for your machine, for example for different locations. This is es-
pecially useful for laptops that need different configurations for home, office, coffee shop,
etc. The parameters that can be switched from one profile to another are:

Network Configuration
Activates different interfaces, with different configurations, for wireless-type connec-
tions, for example.

Services Configuration
Allows you to activate different services from one profile to another, for example a
firewall at home and no firewall at the office (see Section 2, “Configuring Start-Up
Services” [102]).

6.1. Profile Handling

New profiles you want to create are based on the active one. All modifications are auto-
matically recorded in the active profile.
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Figure 6.15. The Network Profiles Interface

Activate
Make the selected profile active.

New
Creates a new profile. Click on New. Enter name for new profile. A dialog pops up
asking for the name of the new profile. This new profile is now activated. Configure
needed information. You can choose a list of modules to configured for this new pro-
file. Click on Avdanced. Check boxes to be used: Network connection settings, Fir-
wall settings (using IPv6 or not), proxy settings and urpmi settings.

Delete
Deletes the currently selected profile without further prompts. Please note that a warn-
ing is shown if you try to delete the active profile, because it cannot be removed while
it is in use.

The Default Profile.  This is the profile that is used at boot time. It cannot be deleted.
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Example: Create a New Profile for Your Dial-Up Home Connection.  You come
back home with your brand new laptop, which your system administrator configured so
you can connect to your corporate network. You now want to configure the network to
access the Internet from home with a dial-up connection.

1. Create a new profile called “Home”.

2. Reconfigure your network so that the modem, instead of the network card, is used
to access the Internet (see Section 2, “Network and Internet Connection Manage-
ment” [75]).

3. Connect to the Internet.

4. When back at the office, switch back to the “default” profile.

7. Configure VPN Connections

DrakVPN allows you to setup a Virtual Private Network with a remote VPN serv-
er. Protocols supported are Cisco VPN Concentrator and OpenVPN. You can find this tool
in the Network & Internet  section of the Mandriva Linux Control Center.

8. Manage Hosts Definitions

If you have fixed IP addresses on your network, Drakhosts allows you to associate
names to those IP addresses, easier to remember. You can find it in the Network & Internet
section of the Mandriva Linux Control Center.
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Figure 6.16. Modifying Drakhost Main Window

If you want a specific machine on your network to provide services, such as Internet gate-
way, file serving, databases, etc., assigning a host name to it will make systems adminis-
tration easier. With this tool you can add a name to the host IP address in order to manage
hosts more easily.

You can:

• add a machine to your network, click on the Add button and fill the fields: add the IP
address , the host name and if needed host aliases .

• change or add a name to an existing host by selecting it and clicking on Modify . Simply
add or change the Host name field and add Host aliases  if needed.

You can find the IP address of a host by placing your mouse cursor on the net
applet.
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9. Firewall Black/White Lists, etc.

This tool is used to detect suspicious or abnormal activities and warns you of intru-
sion attempts to your machine. You can access it via the net applet by right clicking on it
and choosing Interactive Firewall  from the pop-up menu.

Even if your machine is protected by a firewall, intrusion attempts can be made, we rec-
ommend that you use this tool to monitor security status and to detect any intrusions.

9.1. Enabling and Accessing Interactive Firewall Feature

When you set up your firewall configuration, check the Use Interactive Firewall  option
to enable this feature. (Refer to Section 2, “Securing your Internet Access via DrakFire-
wall” [154] for more details about firewall settings).

Each time a remote host tries to connect to one of the open ports on your system the tool
pops up a message: click on it to view the full log of the connection attempt and to manage
these remote hosts by allowing or denying their access.
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9.2. Monitoring and Managing Intrusions

Figure 6.17. Interactive Firewall Window

The Log tab shows connection attempt details: the date and time, the IP address of the
machine trying to connect to yours, the service or port and protocol, and the network in-
terface on which the connection attempt was made.

You can the manage the remote hosts access with the following buttons:

Blacklist
Forbid connections to addresses selected.

Whitelist
Allow access to addresses selected.

Open the Blacklist  tab to view all the forbdden remote hosts. You can then:
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Remove from blacklist
Remove a remote host from the black list.

Move to whitelist
Allow a remote host by adding them to the whitelist.

Open the Whitelist tab to view all the allowed addresses. You can then:

Remove from whitelist
Remove addresses from this list.
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Chapter 7. Personalizing your System

1. Users Authentication

 Drakauth is a tool that allows you to change the way users are authenticated
on your computer. You can find it in the System section of the Mandriva Linux Control
Center.

Figure 7.1. Authentication Window

You can change the authentication method only if your system administrator
asks you to do so.

If you select a method other than Local file , you need to provide parameters which vary
from one method to the other: ask your network administrator.
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2. Configuring Start-Up Services

Abstract

 At boot time, the system starts a number of services (programs which run in
the background to perform a variety of tasks). This tool gives the administrator control
over those services.

Figure 7.2. Choosing the Services Available at Boot Time

For each service, this is the list of items found in each column:

• Service name;
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• Current Status: either running or stopped;

• Info : click on this button to get a little explanation about this service;

• On Boot: check this box if you wish this service to be automatically started at boot
time.1Alternatively, if xinetd is installed and the service is a xinetd service, the label
Start when requested will be displayed. Checking the box will then mean to activate
that service in xinetd. You will also have to make sure that the xinetd service itself is
activated.

• Start: immediately starts the service, or restarts it (stop+start) if it is already running;

• Stop: immediately stops the service.

After pressing the Start or Stop buttons, a tool tip shows you the status of the operation.

3. Managing Fonts on your System with DrakFont

Abstract

 This tool allows you to review the different font families, styles, and sizes
available on your system. It also allows for fonts to be installed or removed.

The main window (see Figure 7.3, “DrakFont's Main Window” [104]) shows a visual
appearance of the currently selected font combination.
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Figure 7.3. DrakFont's Main Window

drakfont is made up of a number of dialogs which are accessible through the buttons located
at the bottom.

Get Windows Fonts
This button automatically adds fonts found on your Windows ® partitions, if any, of
your local hard drives.

Options
Allows you to specify which applications and devices (such as printers) will support
the fonts. Select those you want support for and click on the OK button.

Uninstall
Allows you to remove installed fonts, in order to save space for example. Use this
with great care, it could have serious side effects for your applications. In particular
you should not remove fonts you did not install yourself.



Setting your Machine's Date and Time

105

This actually removes all fonts found in a given directory. Note that fonts manually
added through drakfont are found in /usr/share/fonts/drakfont/.

Import
Allows you to manually add fonts found outside the Mandriva Linux distribution,
from a fonts disk you have purchased or from the Internet, for example. Supported
font types are ttf, pfa, pfb, pcf, pfm, gsf. Clicking on the Add button opens a
standard dialog allowing you to specify the font file to import. Once you've specified
all the fonts you want to import, click on the Install  button.

Selecting more than one font

To select more than one font, press and hold the CTRL key while selecting
the fonts you want to install and click OK, they will be added to the Import
Fonts  window. Then, click on the Install  button.

When adding or removing fonts, the change might not appear immediately in
the font list. Close and re-launch drakfont to ensure your changes were taken
into account.

4. Setting your Machine's Date and Time

Abstract

  This little tool enables you to set your system's correct internal date and time.
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Figure 7.4. Changing Date and Time

You set the date on the left and the time on the right:

1. To change the year, click on the little arrows on each side of the year; same procedure
to change the month. This updates the month view where you can click on the current
day in order to highlight it.

2.  We recommend that you check the timezone settings for your geographical location.
Click on the Change Time Zone button and select the correct place in the tree view.

Once you've chosen the timezone, a dialog appears asking you whether your hardware
clock is set to GMT. Answer Yes if only Linux is installed on your machine, No
otherwise.

3. To change the time, you can either move the hour, minute and second hands of the
analog clock, or change the numbers below.
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4. If you have a permanent Internet connection and want your system to synchronize its
internal clock with time servers on the Internet, put a check mark in the Enable Net-
work Time Protocol  option and select a server in the Server  pull-down list, preferably
one near you. If you know the name or the IP address of a local server you can also
enter it manually in that field.

When you're finished, click on OK to apply your settings or Cancel  to close the tool,
which will discard your changes. If you want to return to your previous settings, click on
Reset .

5. System Localization

Localedrake is a tool that allows you to switch the main language of the system,
as well as locale settings. You can find it in the System section of the Mandriva Linux
Control Center.

Figure 7.5. Selecting the Language of the System
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1. Choose the language you want to use. The available languages correspond to those
selected during the installation of the system, so be sure to select all the languages you
are likely to use during the installation steps.

The Advanced  button allows you to activate the old compatibility (non-UTF8) encod-
ing.

2. Choose the country or region: the list displays only the countries speaking the language
you selected at the previous step. If the country you are looking for is not listed, click
on Other countries  to access the full list.

You need to restart the system for these changes to take effect.

6. Monitoring System Activity

Abstract

 This tool allows you to look for specific entries in various log files, making it
easier to search for particular incidents or security threats.

Additionally a nifty wizard allows you to set up mail alerts to warn you whenever the load
is too high on your machine, or when a service is down.
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6.1. Browsing System Logs

Figure 7.6. Browsing and Searching through System Logs

These are the steps to follow in order to browse or look for a specific event into the system
logs:

1. You must choose which specific words to match by filling the Matching field (log
files contain the words) and/or the but not matching field (log files which don't con-
tain the words). At least one of the two fields must be filled.

2. Then in the Choose file area select the file you want to perform the search on. Simply
check the corresponding box.
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The Mandriva Linux Tools Logs are filled by Mandriva Linux-specific
configuration tools, such as those you find in the Mandriva Linux Control
Center. Each time these tools modify the system configuration they write
to this log file.

3. Optionally, you can restrict the search to a specific day. In that case, check the Show
only for the selected day box and choose the desired day from the calendar.

4. When all is set up, click on the Search button. The results appear in the Content of
the file  area at the bottom.

Clicking on the Save button opens a standard dialog letting you save the search results
into a plain text (*.txt) file.

6.2. Setting up Mail Alerts

Abstract

In order to facilitate server monitoring, Mandriva Linux supplies a simple tool which sends
automatic mail alerts whenever something goes wrong on your server.

Clicking on the Mail alert button of the LogDrake main interface (see Figure 7.6, “Brows-
ing and Searching through System Logs” [109]) starts the wizard. First you're asked
whether you wish to configure or stop the mail alert system. Choose Configure the mail
alert system entry in the pull-down list, and click Next.
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Figure 7.7. Setting up a Mail Alert: Services

The next step (Figure 7.7, “Setting up a Mail Alert: Services” [111]) allows you to select
the services you wish to receive alerts about if they stop working. Simply check the service
boxes which interest you.

The services listed are the ones present on your system. Here's a list of the cur-
rently trackable ones:

• Postfix Mail Server;

• Webmin Service;

• FTP Server;

• BIND Domain Name Resolver;

• Apache World Wide Web Server;

• SSH Server;

• Samba Server;

• Xinetd Service.
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Figure 7.8. Setting up a Mail Alert: Load

Select the load which you consider unacceptable by moving the Load slider (Figure 7.8,
“Setting up a Mail Alert: Load” [112]). A high system load may indicate that a process
has gone out of control, or simply that there's a very high demand on this machine. There-
fore a service is suffering from it and is delayed. As a rule of thumb, the load on your
computer should not exceed 3 times the number of processors you have on it.
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Figure 7.9. Setting up a Mail Alert: Recipient

Finally you need to tell the system to whom these alerts should be sent (Figure 7.9, “Setting
up a Mail Alert: Recipient” [113]). Provide an e-mail address and the mail server (local
or on the Internet) to relay the alerts to.

When the wizard is finished, an hourly check is set up to verify services availability and
the system's load. If needed a mail alert is sent to the alerts' recipient until the problem
is solved.

7. Access to the Console

   This tool simply opens a virtual terminal console for the root user. You
can use it to issue any command, but be careful! There are no restrictions on the actions
you can take on your machine as root, and you could render your machine unusable.
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 To learn how to use the command line interface, you should read  the Introduction to the
Command Line chapter of the Mandriva Linux Reference Manual Chapter 15, Introduction
to the Command Line [199]. To exit the console, type exit or press the Ctrl+ D keys.

8. Managing Users and Groups

Abstract

   UserDrake allows system administrators to easily add and remove users from the system,
to assign users to a group, and to manage user groups in the same manner.

In this section we will only focus on user management. Group management is
similar.

8.1. The Interface
Launching UserDrake will display the main window (Figure 7.10, “The User List in User-
Drake” [114]) which lists the users currently defined on the system. You can switch
from users to groups by clicking on the Groups tab next to the Users tab.

Figure 7.10. The User List in UserDrake
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All changes have immediate effect on your local user database. If the user list is modified
outside of UserDrake, you can refresh UserDrake's window by clicking on the Refresh
button.

If you make changes to an already logged in user, those changes won't take
effect until the next time that user logs in again.

Available actions are:

Add User
Adds a new user to the system. We detail this procedure in Section 8.2, “Adding a
New User” [115].

Add Group
Adds a new user group to the system.

Edit
Allows you to change the parameters of the selected user or group. We detail editing
user parameters in Section 8.2, “Adding a New User” [115]. In the case of a group
you will be able to assign or remove users from that group.

Delete
Removes the selected user or group from the system. A confirmation dialog will be
shown, and in the case of a user you will also be able to remove the user's /home
directory and mailbox.

8.2. Adding a New User

We created the non-privileged user Queen Pingusa at installation time, and now we want
to create a new user called  Peter Pingus. Then we want to make them both members of
the fileshare group, so that they can share folders with other users on the network (see
Section 3, “Allowing Users to Share Folders” [150], custom option).

Click on the Add User  button, a dialog box to add a new user will pop up (see Figure 7.11,
“Adding a New User in the System” [116]). The only required field is Login although
we strongly recommend that you set up a password for this new user: enter it in both the
Password and Confirm Password fields. You can also choose to add a comment in Full
Name. Generally, this is the full name of the user, but you can put whatever you want. Once
you accept your settings you are asked if you wish to run the Windows® data migration
wizard, please refer to Section 9, “Import Windows® Settings and Documents” [118]
for more information.
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Figure 7.11. Adding a New User in the System

 We now have two users in our list. Select one of them with your mouse, and click on the
Edit  button. The dialog box shown in Figure 7.12, “Adding Users to a Group” [117]
pops up. It allows you to modify most available user parameters.
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Figure 7.12. Adding Users to a Group

The dialog is made of the following tabs:

User Data
Allows you to modify information provided when the user was created.

Account Info
Enables you to provide an expiration date for that account, after which the user won't
be able to connect to the system. This is useful for temporary accounts. It's also pos-
sible to temporarily lock an account to prevent a user from logging in. Finally, this tab
allows you to change the icon associated with the user.

Password Info
Allows you to provide a password expiration date, after which the user will be required
to change his password.

Groups
Shows the list of available groups where you can select the groups to which any user
should belong.

For our users we only need to look for the fileshare entry and check the box associated
to it. Then click on the OK button to make the changes effective.

8.3. Guest account
You can use interface to add/remove a guest account. You can use this account to allow
somebody to use safely your system. Guest account is a temporary account, it can be only
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used to log in via gdm or kdm. Home and temporary directories for this user are mounted
and available only when account is used. Then it just disappears. So you should backup
data if you get some in this account.

Guest account is enable by default. Choose guest in connection manager window, without
any password. To disable it, choose Options menu and click on Uninstall guest account .

9. Import Windows® Settings and Documents

Transfugdrake allows you to import settings and documents from your Mi-
crosoft® Windows® partition into your Mandriva Linux partition, in order to ease your
migration from Windows® to Mandriva Linux. The wizard consists of a few simple steps,
detailed below.

Transfugdrake only supports migration from the Windows® 2000, Windows®

XP, and Windows Vista® operating systems.

Please bear in mind that each wizard operation takes effect immediately after
clicking Next.

Procedure 7.1. Migrating User Settings and Documents

1. If you have more than one user on your operating systems, you are asked to select the
source (Windows®) and target (Mandriva Linux) users: use the corresponding pull-
down lists to select users.
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2. You are then asked whether you want to migrate documents. Select the Skip step
option if you don't want to migrate documents right now, but are interested in migrat-
ing settings.
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Select the Import documents  option to copy documents from the Windows® partition
to your Mandriva Linux system. Use this if you don't plan to use Windows® anymore
and want to be able to delete its partition without too much risk of data loss. Files and
folders from “My Documents”, “My Pictures” and “My Music” are copied over to
the user's Documents, Pictures and Music folders, respectively.

Please be patient, depending on the amount of information to transfer, the
copying operation may take a long time to complete.

3. Select the Import bookmarks option to import the web browser bookmarks. Both
Microsoft® Internet Explorer® and Mozilla Firefox bookmarks are merged with the
user's Mozilla Firefox bookmarks on Mandriva Linux.
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If you select the Skip Step option web browser bookmarks are not imported and you
will have to rebuild your Windows® bookmarks collection one by one.

4. Simply select the Use Mandriva background option to keep your current Mandriva
Linux desktop's background image, or select Import background to use the desktop
background image from Windows® instead.
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10. System Snapshots

   Draksnapshot is a tool that allows you to perform system snapshots, which is
a kind of backup, using a special strategy to avoid duplicating equal files in order to save
disk space. You can find it in the System section of the Mandriva Linux Control Center.
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Figure 7.13. Draksnapshot Main Window

Check Enable Backups, choose Section 10.1, “What to Backup” [123] and Section 10.2,

“Where to Backup” [124], then click Apply . You can then choose File → Quit to
close draksnapshot.

10.1. What to Backup

10.1.1. Backing-up the Whole System

Check Backup the whole system to backup the whole system. Please bear in mind that
this will take a lot of disk space.

10.1.2. Backing-up Specific Folders

When the Backup the whole system option is not checked, only some folders are backed
up:
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• the folder where the system's users personal folders are stored,

• the folder where system configuration is kept,

• the folder where programs are stored.

Click on Advanced to change what's included in the snapshot.

Figure 7.14. Including and Excluding Files and Folders From the Snapshot

Backup list
shows folders and files that will be included in the backup.

Exclude list
shows folders and files, residing on the folders listed in the backup list, that will not
be included in the snapshot.

Use the Add and Remove  buttons at the side of each list to populate both lists. If the ex-
clusion list is empty, whole folders and files of the backup list are included in the snapshot.

10.2. Where to Backup

By default snapshots are stored in the (hidden) /home/.snapshots folder. Click on
Browse to select a different folder to store snapshots into.
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Backup on a Remote Media

If you have a remote folder mounted on your file system, you can select that
folder to perform the backup on the remote machine, on an external USB disk,
etc.
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Chapter 8. Network Sharing

1. Importing Remote SMB Directories

Abstract

     This tool allows the system administrator to give users access to remotely
shared directories using the SMB protocol (used mainly by Windows®).

While users can individually access remote shares through their file managers, it may be
required in some cases to import a specific share for it to become immediately available
for all users. We'll go through an example showing you how to import a directory from
a Windows® machine.

Figure 8.1. Scanning the Whole Network
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Choose a Server.  Clicking on the Search servers button scans the local network for
machines which currently share directories (including the local one). We'll choose one of
them and make it available locally for all users.

Procedure 8.1. Choose a Share

1. Click on a machine name, then on the little arrow at the left of the machine icon to
show available shares. Then select the one you wish to configure.

If the machine you're connecting to has both public and password-protected
shares, then canceling the password entry dialog will connect you to that
machine, but only to its public shares.

2. Once a share is selected, a Mount point button appears, click on it to enter the local
directory name where remote files will be accessible.

3. Once this is done, two more buttons appear:

Options
Allows you to set a user name and password to access that SMB mount point. Oth-
er permissions and advanced settings can also be set through this button. Make
sure you set at least the username, or leave all options empty to use defaults.

Mount
Makes the resource available locally. When this is done, users simply have to
point their file manager to the directory selected as the mount point to get the
files hosted by the server.

Import Share on Each Reboot.  When you're finished configuring the access points
for remote directories, click on Done. A dialog box will appear asking you whether or
not you wish to save your modifications to the /etc/fstab file (where mount point
information is usually stored). Click on Yes to make the share configurations persistent
between sessions. Click on No to exit without saving your changes.

2. Samba Shares Managements

This tool allows you to define which folders and printers on your machine can
be accessed by other machines on the network by means of the SMB/CIFS protocol, main-
ly used by Windows® machines. You can find it in the Network Sharing section of the
Mandriva Linux Control Center.
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Figure 8.2. DrakSamba Main Interface

The interface is composed of three tabs we will detail now, to manage folder shares, printer
shares, and users allowed to access those shares.

2.1. Basic Server Setup

The first time you run the tool a wizard helps you configure basic server settings.

1. Select the PDC option to have your system act as a domain controller for a Windows®

network. Select the Standalone option to have your system act as a standalone server,
not part of any domain. This is the recommended setting for simple file and print
sharing services.
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Figure 8.3. Standalone Samba Server

2. Fill the Workgroup field with the name of the workgroup the system will serve. Fill
the Netbios name field with the NetBIOS name of the system, that is the name your
server will be known by other machines on the network.
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Figure 8.4. Workgroup and Server Names

3. Use the Security mode pull-down list to choose the security level from user  (clients
authenticate once per session), share (clients authenticate per share) and domain
(clients authenticate on a domain controller). The user level security mode is the rec-
ommended option.
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Figure 8.5. User Level Security Mode

4. Fill the Banner  field with a phrase to describe your system on the network. Please
note that this phrase is arbitrary, however it is advisable to put something meaningful
to the services your system will provide to the network.
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Figure 8.6. File Server Banner

5. Choose the log settings: log file name, maximum log size (in KB), and the verbosity
level. It is recommended that you leave settings at their defaults, that way there will
be a per-client log file with reasonable maximum size and verbosity.
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Figure 8.7. Per-Client Small Log File Setting

6. Finally, review your settings and click Ok. Settings are applied and the Samba ser-
vice is started.

2.2. Samba User Management
You must add a Samba user for each client that needs to connect to the Samba server for
file and print sharing.

Procedure 8.2. Adding a Samba User

1. Open the Samba Users  tab.

2. Click on Add, use the User name pulldown list to select the users defined in the
Mandriva Linux system, then fill the password field.

To simplify the configuration and connection of shared resources on Win-
dows® clients, it's very important that both the user and password you set
on the Mandriva Linux server are the same as the ones set for the client on
his Windows® machine. Please bear in mind that case is important for both
user and password, so Peter and peter refer to two different users.
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2.3. File Sharing Settings

By default, the home file share is defined, giving Samba users access to their home folders
on the Mandriva Linux server. We describe below how to add a public share with read/
write access for all clients.

Procedure 8.3. Adding a File Share Resource

1. Open the File share tab.

2. Click on Add, fill the Name of the share (it can be any name, meaningful to the share
contents, in our example “Public”); the Comment  (again, it should be descriptive
of the share contents, in our example “Public R/W Share”); and Directory with the
name of the folder (it must be an existing folder) to be shared (for example, /home/
samba/Public).

3. Click Ok once you are satisfied with your settings.

Procedure 8.4. Modifying a File Share Resource

1. Open the File share tab.

2. Select the share to change (in our example, Public) and click on Modify .
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3. In the Samba share directory section change the Public  (the file share is publicly ac-
cessible), Writable (it can be written to) and Browsable  (it is shown on the Windows®

client “Network Neighbourhood”) options to yes using the corresponding pulldown
lists.

4. You can optionally fine tune file permissions, file creation masks, filename case, and
more options by opening the corresponding Advanced options.

5. Click Ok once you are satisfied with your settings.
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2.4. Printer Sharing Settings

By default, all printers configured in the Mandriva Linux system are available for the
clients of the Samba server, and there's also a special printer named pdf-gen which
generates PDF files, available only to valid Samba users. Select a printer share and click
on Modify  to fine tune printer sharing settings (valid users, printer drivers, etc.)

3. Importing Remote NFS Directories

 This tool is exactly the same as the one mentioned in Section 1, “Importing
Remote SMB Directories” [127], except that it controls file sharing with the NFS pro-
tocol rather than SMB. Therefore it allows you to locally import shared files from NFS-
friendly machines. The interface and its effects are similar to the one described in Sec-
tion 1, “Importing Remote SMB Directories” [127]. Only the corresponding machines
are different: UNIX ® for NFS and Windows ® for SMB.
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One other difference is that there is no need to provide a password to access NFS shares.
The authentication mechanism is host-based.

4. Share Drives and Directories using NFS

Draknfs is a tool that allows you to create and maintain shares to be mounted
by other UNIX® machines on the local network. You can find it in the Network Sharing
section of the Mandriva Linux Control Center.

Figure 8.8. The DrakNFS Main Window

Procedure 8.5. How to Modify or Add a NFS Share

1. Click the Add button or select an entry and click Modify .
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2. Choose a Directory  to be shared.

3. Configure the various access options by consulting the corresponding Information
buttons.

4. Click OK.

5. Allowed hosts can then access this share using Section 3, “Importing Remote NFS
Directories” [137].

5. Setting up WebDAV Mount Points

Abstract

  WebDAV (Web-based Distributed Authoring and Versioning) is an extension
to the HTTP protocol which allows you to create, move, copy, and delete resources on
a remote web server. In practice, mounting a remote WebDAV repository on your local
machine allows you to modify a remote web server's files as if those files were local to
the system.

Browse the WebDAV Resources [http://www.webdav.org/] pages to learn more
about this extension protocol.

http://www.webdav.org/
http://www.webdav.org/
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Figure 8.9. Managing WebDAV Mount Points

1. The first time you launch this tool the required packages are installed if needed, and
only two buttons are available. New, which allows you to define a new mount point,
the other one just Quits the application. After you have defined the mount points,
they will appear as new buttons at the top of the buttons list. Clicking on a mount
point button will take you to the mount point menu (see Figure 8.10, “WebDAV
Menu” [141]).

2. When you click on the New button you are asked for the URL of the web server.
Enter the complete URL of the web server, beginning with http:// or https://,
then click OK.
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3.

Figure 8.10. WebDAV Menu

You must now decide where the web server files will be accessible from. Select the
Mount point option and click OK. Here you are able to choose a local directory or
enter your own. If the selected mount point does not exist, it will be created.

4. If the server requires authentication, do not forget to fill the username and password
fields in the Options dialog. Then all you need to do is to actually mount the remote
repository by selecting Mount and clicking OK.

5. You are now able to browse and modify files on the local mount point you have
defined and the changes will be immediately available on the web server.

6. To make your settings persistent between sessions, remember to save modifications
to the /etc/fstab file, as suggested when you quit the wizard.
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Chapter 9. Local Disks

1. Managing your Hard Drive Partitions with DiskDrake

   Partitions are initially set up during the installation process. DiskDrake allows
you, to some extent, to resize your partitions, move them, etc. DiskDrake can also deal
with RAID devices and supports LVM but we will not discuss these advanced uses here.

DiskDrake is very powerful and can therefore be a dangerous tool. Misuse could
very easily lead to data loss on your hard drive. Because of this potential loss
of data, you are strongly advised to take some protective measures before using
DiskDrake:

1. Back up your data. Transfer it to another computer, or the removable medium
of your choice.

2.  Save your current partition table (the table describing how your disks
are organized) to a floppy disk (see Section 1.2, “DiskDrake's Action But-
tons” [145]).
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1.1. The Interface

Figure 9.1. DiskDrake's Main Window

 DiskDrake enables you to manage partitions on each physical hard drive on your machine,
and also on removable drives: USB hard disks, keys, memory cards, etc. You can see as
many tabs as hard drives your system has. Each tab is named after the Linux name for that
drive (for example: sda for the first hard disk).

The window (see Figure 9.1, “DiskDrake's Main Window” [144]) is divided into four
zones:

• Top. The structure of your hard drive. When you launch DiskDrake it will display the
current structure of the drive. The display is updated as you make changes.

• Right. A menu relevant to the partition currently selected in the above diagram.

• Left. A description of the selected partition.

• Bottom. Buttons for executing general actions. See Section 1.2, “DiskDrake's Action
Buttons” [145].
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We will now review the actions available through the buttons at the bottom of the window,
and then describe a practical use case.

1.2. DiskDrake's Action Buttons

Clear all
Clicking on this button will clear all partitions on the current hard drive.

Toggle to expert mode
This button allows you to access the expert mode functions (which are even more
dangerous if you are not sure what you are doing). Reserved for experts.

Help
Displays documentation in a browser window.

Done
Saves your changes and exits DiskDrake.

You may not remember the content of existing partitions. Click on View, you
will be able to browse content of all your partitions

1.3. Resizing an Old Partition and Creating a New One

We are now going to do a little exercise to demonstrate one of the more useful features
of DiskDrake. Let us imagine that you decide to use your machine as an FTP server and
you want to create a separate /var/ftp partition in order to host the FTP files. Note that
doing this step-by-step tutorial will actually modify the structure of your hard drive.

1. Reboot the machine and press the Ctrl+ Alt+ F1 keys at the login screen.

2. Login as root and run the command: xinit -e diskdrake -- :1

3. This is what the current /home partition looks like before modification. We are going
to shrink this partition in order to create free space for the new file system.
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First of all, you need to unmount the /home partition by clicking on it and then
pressing the Unmount  button.

4. The next step, as you may have guessed, is to click on the Resize  button. A dialog
appears which allows you to choose the new size for the /home partition. Move the
slider to reflect the new size, then click on OK.
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5. When resizing is done, the graphic representation of your hard drive changes. The /
home partition is smaller, and an empty space appears. Click on the empty space and
then on the Create  button. A dialog will let you choose the parameters for the new
partition. Set the size, choose the file system you want to use (usually Journalized
FS: ext3) and then enter the mount point for the partition, which in our example
will be /var/ftp.

This is how our projected partition table now looks like.
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6.  The last step is to format (prepare to host files) the newly created partition. To format
the partition, click on its representation in the partitions picture, then on the Format
button. Confirm the writing of the partition table to disk, the formatting of the partition
and the update to the /etc/fstab file. You may be asked to reboot the computer
to make changes effective.

2. Managing Removable Devices

     These tools allow system administrators to easily control those options
which affect the behavior of removable devices such as floppy, CD and DVD disks. Note
that, by default, all removable devices are automatically made available so users shouldn't
need to manually mount media.

Starting with version 2007.1 of Mandriva Linux, removable media such as CD,
floppy, USB keys and disks, etc. are found under /media/ instead of /mnt/.
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Figure 9.2. Changing a Parameter

For each device the following properties may be changed:

• Mount point.  The directory from where the device's files will be accessed. You can
either choose an entry from the list or type in your own path. If the directory does not
exist, it is created automatically.

• Options.  Controls various device options, notably whether a user is allowed to
use new media without root privileges. By default, the user currently logged on the
system's physical console is given access to removable media.

• Type.  Displays a list of file-system types. If you have a specific medium with a
different file system on it, this is where you can tell Linux how to access it.

Select the property you wish to change and click OK. The corresponding dialog pops up
in which you can change your settings. Then click OK again and save your modifications
to the /etc/fstab file: the device is automatically remounted.
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3. Allowing Users to Share Folders

Abstract

This tool enables you to share files with other users of your computer network.
File sharing can be done on heterogeneous systems such as Linux and Windows ®.

The file-sharing configuration is done in two simple steps: determining who can export
folders, and then which protocol to use. A third step is necessary if you select the Custom
export option.

Figure 9.3. Controlling Exports

1. • No sharing.  Prevents users from sharing data with others.

• Allow all users.  All users are allowed to share data with others.
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• Custom.  By choosing this option, only users within a special group (named
fileshare) will be allowed to share data. If you choose this option, the file-
share group will be created and, as a last step, you will be prompted to run User-
Drake in order to add the allowed users to this group (see Section 8, “Managing
Users and Groups” [114]).

2. You must now choose which protocol(s) to use for file sharing.

• SMB.  If most of your users use Windows® systems, this is the preferable pro-
tocol to select.

• NFS.  If most of your users use UNIX® systems (such as Linux), this is the
preferable protocol to select.

3. Once you have checked the appropriate boxes, click on OK. The required packages
will be installed, if needed. If you uncheck a previously checked box, the correspond-
ing service will be stopped.

4. Lastly, if you have activated the Custom option to allow the users to share folders, you
are prompted to launch UserDrake. There you can add those users to the fileshare
group (see Section 8, “Managing Users and Groups” [114]).
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Users Can Now Share Folders.  Once users are allowed to share data, they can select
the folders to be shared through their preferred file manager .

If you have just added your own user to the fileshare group, you need to
logout and back in for the changes to be taken into account.
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Chapter 10. “Security” Section

1. Setting up Rights Delegation
This tab is used to allow users to perform tasks normally reserved to the system adminis-
trator (root).

Figure 10.1. Delegating Rights

This tab presents most of the tools available in the Control Center, and defines the level
of authentication required to launch each of them:

No password
The tool is launched immediately.

User password
The user password is asked for to make sure he is actually the one using the computer
and launching the configuration tool.
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Root password
The standard behavior: the administrator password is asked for.

Example 10.1. Allow the Users to Manage Network Connections

With the default security level (High), users are allowed to launch the Network Center
without password (by clicking on the network applet). This allows them to manage their
connections themselves.

2. Securing your Internet Access via DrakFirewall

 This little tool allows you to configure the basic firewall installed by default
on your machine. It filters connection attempts made from the outside, and blocks unau-
thorized ones. You will have to configure it if you wish to allow incoming connections to
your computer, if you host specific services on it such as file sharing, Web Server, etc.

This Wizard consists of the steps detailed below.
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2.1. Choosing Services to be Available from Outside

Figure 10.2. The DrakFirewall Window

Open Up Ports, If Needed.  If checked, uncheck the Everything (no firewall)  box,
and then check the boxes corresponding to the services you wish to make available to the
outside world. If you wish to authorize a service which isn't listed here, click on Advanced
to manually enter the port numbers to open and to control the logging of firewall messages.

Opening Unusual Services

Clicking on Advanced opens a field named Other ports  where you can enter
any port to be opened to the outside world. Examples of port specifications are
presented just above the input field: use them as a guide. It's possible to specify
port ranges by using the : syntax such as 24300:24350/udp.

This Won't Block You from Accessing the Net.  Not checking a service in this list
won't stop you from connecting to the Internet. It will only prevent people from the Internet
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connecting to that service on your machine. If you don't plan on hosting any services on
your machine (common case for a desktop machine) just leave all boxes unchecked.

How to Disable the Firewall.  On the other hand if you wish to disable the firewall and
leave all services accessible from the outside, check Everything (no firewall) , but please
bear in mind that this is very insecure, and therefore not recommended.

2.2. Activating Interactive Firewall Feature

Figure 10.3. Interactive Firewall Options

Stay Informed of Connections on your Machine.  The interactive firewall can
warn you of connection attempts on your machine by displaying alert popups through the
network applet. Check the Use Interactive Firewall  option to activate this feature. (Refer
to Section 9, “Firewall Black/White Lists, etc.” [97] for more details.)

Port scan detection
Activate this option to be warned of possible malicious attempts to access your ma-
chine.
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Other entries corresponding to open ports
Next you are shown a checkbox for each port you have chosen to open during the
previous step. Activating them will pop up a warning each time a connection attempt
is made on those ports.

2.3. Which Interface(s) to Protect
The next step consists of selecting the network interface connected to the Internet.

Figure 10.4. The Internet Interface

If you don't know which interfaces you have connected for the Internet, you can check
the system network configuration (see Section 2.2, “Network Center: Reconfiguring and
Monitoring Network Interfaces” [82]). You can finally click OK to install the required
packages, activate the firewall and enjoy your secure Internet connection.

Managing Threats

Consult Section 9, “Firewall Black/White Lists, etc.” [97] to learn how to man-
age threats and how to manage access black and white lists.
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3. Network Interface and Firewall Failover

This tool configures your system so that it can automatically replicate its fire-
wall state to a different machine. In case of failure, it provides a highly available firewall
service for your network. Please note that two firewall machines are needed, both config-
ured similarly.

In t e r n e t

LAN / DMZ
F ir e w a ll Ma s t e r F ir e w a ll S la v e

Figure 10.5. Highly Available Firewall
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The firewall configuration for the master and slave should be similar, or at least have rules
for common services configured identically, so that transparency (at least for those ser-
vices) is achieved. The clients are configured to use the Virtual IP address of the replica-
tion pool.

Firewall replication automatically moves the connection state from the failing firewall to
the replica, providing workstations with an uninterrupted firewall service in a transparent
way. Workstations don't loose their already established network connections to the outside.

Open DrakInvictus choosing Advanced setup for network interfaces and firewall  in the
Security  section of the Mandriva Control Center. At the top you configure network redun-
dancy and at the bottom you configure firewall replication. Please note that this tool has
to be run on each server which is part of the replication pool.

Figure 10.6. The DrakInvictus Window
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3.1. Network Redundancy Configuration
Fill the following fields for the interface corresponding to the network where the other
server (the one providing network redundancy) is located, for example eth0:

Real Address
IP address of the interface. This is the physical address of this server on the network.

Virtual shared address
Virtual IP address shared by both servers. Fill with an unused, fixed, IP address on
the network. This is the address clients will use as their Internet gateway. Please note
that this address must be the same in both master and slave servers.

Virtual ID
Shared identifier number (between 1 and 255). Please note that this ID must be the
same on both master and slave servers.

Password
Provide a password to be used by the replicated machines to identify themselves as
being part of the same replication pool.

Start as master
One of the servers must be declared as Master, to allow for proper recovery when the
master returns to service. Check this box to override the default and recommended
setting of having the system arbitrarily decide which server is the Master and which
is the Slave.

3.2. Firewall Replication Configuration
Check Synchronize firewall conntrack tables  to enable firewall replication and select the
following:

Synchronization network interface
Choose the interface connected to the network on which both firewalls communicate.
Please note that this interface cannot be the same one as used for network redundancy.

Connection mark bit
Bit number of the connection mark field used for connection tracking, you can leave
it at the default value, 30.

4. Parental Controls

  The Parental Controls tool allows you to monitor what children can see and even
place a time-limit restriction to their Internet access. It is a web content filtering tool which
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blocks websites which may have offensive or shocking content. You can also control what
applications can be run by your children. You can find the tool in the Security  section of
the Mandriva Linux Control Center.

The first tie you launch the tool, you are asked whether you wish to activate applications
control. If you wish so, you have to restart your computer as instructed.

Figure 10.7. Parental Controls Main Window

Website filtering is carried out before the site is opened: if it is evaluated as inappropriate,
it will not be opened and a suitable message appears. Choose your settings in the tool and
click Ok once your satisfied with your settings.

If you are requested to install some extra software packages, please accept by
clicking Ok.
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4.1. Defining Main Options

If children are to use your machine, we advise that you create a user account for
them before setting control options.

Check the Enable parental control  box in the Configuration tab to access parental control
settings.

Then select the level of control in the Control level  drop-down list:

• High is generally advised for young children,

• Normal  is for children,

• Low is for young adults.

By default, all users created on the system are subject to parental control. However, in the
User Access  section, you can choose those who won't be under control.

The All users list displays the different user accounts created on the machine. Select users
in the All users list and click on the Add button to put them in the Allowed users  list.
Those users will then be able to access the Internet without restrictions.

4.2. Scheduling a Timeframe

In addition to website filtering, you can define timeframes during which users under
parental control can access the Internet. Check the Allow connections only between these
times box and select the time frame during which access is allowed.

4.3. Using the Blacklist

You can decide to ban certain websites. This can be particularly useful in a professional
environment and especially for network administrators who wish to restrict Internet access.

Simply enter the addresses of these websites in the Blacklist  tab. Fill in the first field
with the URL of the website in question and click on the Add button. Accept the list by
clicking Ok.

Select a URL in the list and click Remove from blacklist  to remove it from the blacklist.

4.4. Using the Whitelist

As opposed to blacklisting, you can decide to authorize access to certain websites banned
by the parental control filtering.
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Simply enter the addresses of these websites in the Whitelist tab. Fill in the first field
with the URL of the website in question and click on the Add button. Accept the list by
clicking Ok.

Select a URL in the list and click on Remove from whitelist  to remove it from the
whitelist.

4.5. Filtering applications
You can decide what applications can be launched or not by a given user. Choose appli-
cations tab and add all applications that should be blocked
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Chapter 11. Boot Device Configuration

1. Configuring the Login Mode

 This tool allows a user to be automatically logged into the system at boot
time, without requiring a password to be entered.

Figure 11.1. Choosing the Login Mode

Here are the available parameters:

Graphical Interface
 If you wish to have the X Window System (graphical display) started at boot time,
check the Launch the graphical environment when your system starts  box. If you leave
it unchecked, the text login will be displayed and you will need to start the graphical
environment manually.
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Autologin
 If you're the only person using your machine and nobody else has access to it, you
may choose to be automatically logged in at boot time.

1. Select the Yes, I want to autologin with this (user, desktop)  option.

2. Choose the user you want to be logged on automatically in the Default user  pull-
down menu.

3. Choose the preferred Default desktop in the pull-down menu.

2. Changing your Boot-up Configuration

This tool allows you to configure how your system boots and which boot
options are available.

Unless you are an expert, it's not recommended that you change these settings
as it may prevent you from booting your machine the next time you try to power
it up.
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Figure 11.2. Choosing the Boot Mode and Main Options

2.1. Configuring the Bootloader
 You can choose between the GRUB and LILO bootloaders. Either one allows you to boot
Mandriva Linux, it's just a question of taste.

Unless you really do know what you're doing, you shouldn't change the default Boot device
shown, because that's where the bootloader installs itself. If more than one OS is installed
on your machine, it's a good idea to delay booting the default OS by at least 5 seconds so
that you can easily select which one to boot.

The dialog finally shows a few options which can be useful depending on your specific
hardware.

Enable ACPI
This option provides better power management support if your hardware is ACPI com-
patible. ACPI is often needed for newer computers which no longer support APM.

Click on Advanced to select extra options:
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Enable APIC
The IO-APIC [http://www.wlug.org.nz/APIC] is only really useful for multi-proces-
sor systems for sending interrupts to the various processors, instead of sending them
to only one processor.

Enable Local APIC
The local APIC can be used by Linux to program interrupts to wake up threads. On
multi-processor machines, it can be used to send interrupts to another processor.

These APIC features are known to cause problems on some computers. These prob-
lems can cause system freezes or incorrect device detection. So you may need to de-
activate them by removing the check from the corresponding boxes.

Clean /tmp at each boot
This option allows you to wipe the contents of the /tmp directory. For instance, it
could contain some files you downloaded from the Internet.

Precise RAM size if needed (found XXX MB)
Use this option to tell Linux how much RAM your machine possesses, if the amount
found differs to what your system actually has, or should this prove to be an issue at
boot time.

2.2. Managing Boot Entries
After clicking Next, the list of available entries at boot time is displayed. The default
entry is marked by a star (*): it corresponds to the one activated if you don't take any action
after a few seconds.

To change the default entry, check the Default  check-box in the Modify  dialog. To change
order in menu, click on up or down arrows to move items.

3. Display Manager Setup

DrakeDM is a tool that allows you to choose the graphical display manager
userd to log onto the machine. Basically, all display managers offer the same features,
it's only a question of taste. You can find it in the Boot section of the Mandriva Linux
Control Center.

http://www.wlug.org.nz/APIC
http://www.wlug.org.nz/APIC
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Chapter 12. Coexisting with
Other Operating Systems

If you plan on using Windows ® as well as Linux by dual-booting (being able to access
either system on the same computer), please note that it is easier to install Windows ®

before Linux. If Windows ® is already set up on your system, and you have never installed
Linux before, DrakX — Mandriva Linux's installation program — will have to re-size
your Windows ® partition. This operation can be harmful to your data. Therefore, you must
perform the following steps before proceeding:

1.     Run chkdsk on your Windows ® computer (also called scandisk on some non-
NT systems, such as Windows ® 9x). The resizing program can detect some obvious
errors, but chkdsk is better suited for this task. Refer to the chkdsk documentation
for more information on the different options it has.

Before using chkdsk make sure your screen saver and any other program
that might write to the hard disk is turned off. To obtain even better results,
you should run chkdsk from Windows ®'s “Safe Mode”, though it will
take longer.

2.   For maximum data security, also run defrag on your partition if you use Windows
® 9x 1. This further reduces the risk of data loss. This isn't mandatory, but it's highly
recommended. Doing so will make the resizing process much faster and easier.

3. The ultimate insurance against problems is to always back up your data! Of course,
you should back up your data on another computer, upload your back-ups onto the
web, on a friend's computer, etc. Do not back it up onto the computer on which you
want to install Linux.
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Chapter 13. Before Installation
This chapter covers issues which should be addressed before you start your new Mandriva
Linux installation. Make sure you read it completely since it will save you a lot of time.
Also back up your data (on a different disk to the one you will install the system into) and
plug in and turn on all your external devices (keyboard, mouse, printer, scanner, etc.).

1. Configuring your BIOS
 The BIOS (Basic Input/Output System) is used to find the device on which the operating
system is located and starts it up. It's also used for the initial hardware configuration and
low-level hardware access.

 The appearance of plug'n'play devices and their widespread use means that all modern
BIOSes can initialize these devices. In order for Linux to recognize plug'n'play devices,
your BIOS must be configured to initialize them.

  Changing your BIOS' settings is usually performed by holding down the Del key (some
BIOSes may use the F1, F2, F10 or Esc keys instead) right after the computer is
switched on. Unfortunately, there are so many types of BIOSes, you will need to look for
the appropriate option yourself. It's often called PNP OS installed  (or Plug'n'Play OS
installed ). Set this option to No and the BIOS will then initialize any plug'n'play devices,
which helps Linux to recognize them.

Look for Boot sequence or First boot device in the BIOS' features setup, and set the CD-
ROM as the first boot device.

 If you want to use a parallel printer connected locally to your machine, make
sure the parallel port mode is set to ECP+EPP (or at least to one of ECP or EPP)
and not to SPP, unless you have a really old printer. If the parallel port is not
set this way you might still be able to print, but your printer will not be detected
automatically and you will have to configure it manually. Also make sure the
printer is properly connected to your machine and powered on beforehand.

2. Supported Hardware
 Mandriva Linux can handle a large number of hardware devices, and the list is far too long
to be quoted exhaustively. You may consult an up-to-date list of supported hardware on
the Mandriva Linux Hardware Database [http://www.mandriva.com/hardware] web site.

 Legal Disclaimer: The Mandriva Linux  Hardware Database contains informa-
tion about hardware devices which have been tested and/or have been reported
to function properly with Mandriva Linux. Due to the wide variety of system

http://www.mandriva.com/hardware
http://www.mandriva.com/hardware
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configurations, Mandriva cannot guarantee that a specific device will work cor-
rectly on your system.

 Support for USB 1.x and USB 2.0 is now extensive. Most peripherals are fully supported.
You can obtain the list of supported hardware on the Linux-USB device overview [http://
www.qbik.ch/usb/devices/] site. Relevant information can also be found on the Linux USB
[http://www.linux-usb.org] web site.

http://www.qbik.ch/usb/devices/
http://www.qbik.ch/usb/devices/
http://www.qbik.ch/usb/devices/
http://www.linux-usb.org
http://www.linux-usb.org
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Chapter 14. Installation with DrakX

1. The Mandriva Linux Installer
With the DrakX installation program, it doesn't matter whether you're a newbie or a Linux
guru. The job of DrakX is to provide you with a smooth installation and an easy transition to
Mandriva Linux's latest version. DrakX also detects existing Windows® and Linux installs
and adds boot menu entries for them, so you can start either operating system.

Make sure that all your hardware is connected to your computer and powered on
during the installation. Printers, modems, scanners and joysticks are just a few
examples of peripherals which DrakX can automatically detect and configure
as Mandriva Linux is being installed.

Procedure 14.1. Begin Installation

1. Place your installation CD or DVD into the reader and reboot your machine. The
installer will start automatically.

2. Press any keyboard key (except Enter ) when you see Mandriva's welcome screen
appear . A list of possible actions is offered, and if you do nothing, the selected action
is carried out when the timer expires.

3. Press the F2 key to have all options displayed in your language. Simply select your
language by using the up and down arrow keys, then press Enter .

If Something Goes Wild

If the default procedure does not work for you, read Section 1.2, “Startup Op-
tions” [176].

1.1. The Installation Process
When the installer starts, you see a nice graphical interface (see Figure 14.1, “Choosing
the Default Language” [176]). On the left are the various installation steps, the current
one is highlighted. The installation occurs in two phases: installation, then configuration.

Steps and Substeps.  Each step may present various screens. You can surf between
those screens with the Next and Previous  buttons. Additionally an Advanced  button
may be available to show more advanced configuration options. Note that most of the latter
should only be used by expert users. But there's no harm in looking at them!

The Help button displays explanations about the current installation step.
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1.2. Startup Options

If something goes wrong during the first installation attempt, boot from the installation
medium again, and depending on your problem, try one of the Fx options at the bottom of
the screen. Select an option and press F1 to get more information about what that specific
option does.

Boot Options.   This line contains the options passed on to the kernel that will be used
for the selected action. Most machines don't require specific kernel options.

2. Choosing your Language

The first step is to choose your preferred language. If you have already changed the lan-
guage at the CD or DVD boot splash screen and don't need to install additional languages,
you can safely move to the next step.

Figure 14.1. Choosing the Default Language
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Open the tree representing the continent you are located in, then choose your language.
Your language choice will affect the installer, the documentation, and the system in gen-
eral.

Multi-Language System.  Use the list accessible through Multi languages to select
other languages to be installed on your system, thereby installing the language-specific
files for system documentation and applications (translations, fonts, spell checkers, etc.)
For example, if Spanish friends are to use your machine, select English as the default
language in the tree view and Español in the list view. You may choose several, or even
install them all by selecting the All languages option. Make sure you select all languages
which are likely to be useful on the machine now, once the system is installed it may be
difficult to configure support for languages not chosen at install time.

UTF-8 (Unicode) Support

Unicode is a character encoding intended to cover all existing languages and al-
phabets, and Mandriva Linux uses it by default. However, if you have previously
noticed problems with it for your language, you can resort to your language-spe-
cific encoding by selecting the Old compatibility (non UTF-8) encoding option.

Switching from one Language to Another

To switch between the various languages installed on your system once it is

installed, go to the main menu and open the Tools → Regional Settings  entry.
To change the language used by the entire system, use the Control Center.
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3. License Terms of the Distribution

 Before continuing, you should carefully read the terms of the license. It covers the entire
Mandriva Linux distribution. If you agree with all the terms it contains, select Accept  and
click Next. If not, clicking on Quit reboots your computer.

Release Notes

If you are curious about any technical changes which have occurred in the dis-
tribution since the last release, you can click on Release Notes .

4. Configuring your Keyboard

This step is activated only if your language settings match more than one keyboard. Oth-
erwise your keyboard is automatically selected.
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  Depending on the language you choose (see Section 2, “Choosing your Lan-
guage” [176]), DrakX automatically selects a particular type of keyboard configuration.
Verify that the selection suits you or choose another keyboard layout.

More Keyboards.  Click on More to display the list of all supported keyboards, if your
keyboard is not in the first list.

Non Latin Alphabets.  If you choose a keyboard layout based on a non-Latin alphabet,
the next dialog allows you to choose the key binding which can switch the keyboard be-
tween the Latin and non-Latin layouts.
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5. Where to Install Mandriva on your Hard Disk

You now have to decide where you will install Mandriva Linux on your hard drive. Your
hard drive needs to be partitioned which means it must be logically divided in order to
create the required space for your new Mandriva Linux system.

 Because the process of partitioning a hard drive is usually irreversible and can lead to data
loss, it can be intimidating and stressful for the inexperienced user. Fortunately, DrakX
includes a wizard which simplifies this process. Before continuing with this step, read
through the rest of this section and above all, take your time.

DrakX will represent your disks and the way they are already partitionned. You will be able
to see Mandriva Linux previous partitions but also Microsoft Windows® one. Depending
on the configuration of your hard drive, several options are available:

Use free space
This option performs an automatic partitioning of any blank areas of your drive. If
you use this option there will be no further prompts.
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Use existing partitions
 The wizard has detected one or more existing Linux partitions on your hard drive.
If you want to use them, choose this option. Then choose the mount points to be as-
sociated with each of the partitions. The legacy mount points are selected by default,
and for the most part it's a good idea to keep them. Then choose the partitions to be
formatted or preserved.

Erase and use entire disk
Choose this option to delete all existing data and partitions present on your hard drive.
You won't be able to undo this operation after you confirm.

If you choose this option, all data on your disk will be deleted.

Remove Microsoft Windows®
This option appears when the hard drive is entirely taken by Windows ®. Choosing
this option simply erases the entire drive, partitioning everything from scratch.

If you choose this option, all data on your disk will be lost.

Use the free space on a Microsoft Windows® partition
If Windows ® is installed on your hard drive, you might have to create free space for
Linux. To do so, you can either delete your Windows ® partition and data (see the
“Erase and use entire disk” solution) or resize your FAT or NTFS partitions. Resizing
can be performed without the loss of any data, provided you have previously defrag-
mented the Windows ® partition. Backing up your data is strongly recommended. Us-
ing this option is recommended if you want to use both Mandriva Linux and Windows
® on the same computer.

Before choosing this option, please understand that after this procedure, the size of
your Windows ® partition will be smaller than when you started, which means you
will have less free space to store your data or to install new software.

Custom disk partitioning
 Choose this option to manually partition your hard drive. Be careful: it's a power-
ful but dangerous choice and you can very easily lose all your data. This option is
only recommended if you have performed custom disk partitioning before, and have
enough Linux experience. For more instructions on how to use the DiskDrake utility,
refer to Section 1, “Managing your Hard Drive Partitions with DiskDrake” [143].
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6. Choosing Mount Points

This step only shows if you have chosen to reuse existing Linux partitions.

Listed here are the existing Linux partitions detected on your hard drive, with the corre-
sponding associated mount points. If you are unsure, keep the automatic settings.

Each partition is listed as follows: “Name” (“Capacity”, “Detected mount point”, “File
System Type”).

6.1. Manual Choice

If for any reason the mount points are not detected or if you make changes, you must at
least define a   root partition (/). Do not choose too small a partition or you will not be
able to install enough software. If you want to store your data on a separate partition, you
will also need to define a /home partition (only possible if you have more than one Linux
partition available).

6.2. Partition Naming

A partition name (for example sda1) is made up of three parts: “hard drive type”, “hard
drive number”, “partition number”.

7. Choose the Partitions to Format

This step is only available if you choose to reuse existing Linux partitions.
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 You may wish to reformat some of your legacy Linux partitions and to erase any data they
contain. To do so, please select those partitions as well.

Please note that you don't have to reformat all  pre-existing partitions. You must reformat
the partitions containing the operating system (such as /, /usr and /var) but not the
partitions containing data you wish to keep (typically, /home).

Please be careful when selecting partitions. After the formatting is completed, all data on
the selected partitions is deleted and you won't be able to recover it.

• Click on Next once you've selected the partitions to format.

• Click on Previous  if you want to choose another partition for your new Mandriva Linux
operating system installation.

•  Click on Advanced if you want to check for partitions with bad blocks on the disk.
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8. Package Selection
We now enter the software package installation itself. It consists of selecting the installa-
tion media and the packages to be installed.

8.1. Choosing the Installation Media
Select Available CDs.  If you are doing an installation from a CD, you are first asked
to select the CDs you actually have available.

Copy whole CDs.  You are also given the option to copy all packages on to your hard
drive. This will probably speed up installation and will ease later package installation as
all packages will already be available on your hard disk.

8.2. Choosing Package Groups to Install

This window is activated only if you choose the Custom install  in the previous
step.
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 It's now time to specify which applications you want to install on your system. There are
thousands of packages available for Mandriva Linux, and to make it simpler to manage,
they have been placed into groups of similar applications.

Mandriva Linux further sorts package groups into general categories. You can mix and
match applications from the various categories, so a Workstation installation can still have
applications from the Server  category installed.

1.  Workstation: if you plan on using your machine as a workstation, select one or more of
the groups in this category. The special LSB group will configure your system so that it
complies as much as possible with the Linux Standard Base Project [http://www.linux-
foundation.org/en/LSB] specifications.

2.  Server : if your machine is intended to be a server, select which of the most common
services you wish to install on your machine.

3.  Graphical Environment: this is where you can choose your preferred graphical envi-
ronment. You must select at least one if you want to have a graphical interface available.

Moving the mouse cursor over a group name displays a short explanatory text
about that group.

Select Individual Applications.  You can check the Individual package selection box,
which is useful if you are familiar with the packages being offered, or if you wish to have
total control over what will be installed.

Upgrade Applications Only.  If you start the installation in Upgrade mode, you can
deselect all groups and prevent the installation of any new packages. This is useful for
repairing or updating an existing system.

8.3. Minimal Installation
If you deselect all groups when performing a regular installation (as opposed to an up-
grade), a new dialog is displayed after pressing Next, suggesting different options for a
minimal installation:

• With X: installs the minimum number of packages possible to have a working graphical
desktop.

• With basic documentation: installs the base system plus basic utilities and their docu-
mentation. This installation is suitable for setting up a server.

• Truly minimal install : installs the absolute minimum number of packages necessary to
get a working Linux system. With this installation, you will only have a command-line
interface.

http://www.linux-foundation.org/en/LSB
http://www.linux-foundation.org/en/LSB
http://www.linux-foundation.org/en/LSB
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8.4. Choosing Individual Packages to Install

If you choose to select which packages to install, the installer presents a tree structure
containing all packages classified by groups and subgroups. While browsing the tree, you
can select entire groups, subgroups, or individual packages.

Package Description.  Whenever you select a package on the tree, a description appears
to let you know the purpose of that package.

Server Applications

If a server package has been selected, either because you specifically chose the
individual package or because it was part of a group of packages, you are asked
to confirm that you really want those server packages to be installed. By default
Mandriva Linux will automatically start any installed services (servers) at boot
time. Even if they are safe and have no known issues at the time the distribution
was shipped, it is entirely possible that security holes were discovered after this
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version of Mandriva Linux was finalized. If you don't know what a particular
service is supposed to do or why it's being installed, then click No.

Dependencies Between Packages.  Uncheck the Show automatically selected pack-
ages option to disable the information dialog that appears whenever the installer automat-
ically selects a package to resolve a dependency issue. Some packages depend on others
and the installation of one particular package may require the installation of others. The
installer can determine which packages are required to satisfy a dependency, and to suc-
cessfully complete the installation.

Load/Save the List of Packages.  The little floppy disk icon at the bottom of the list
allows you to load or save the package list. This is useful if you have a number of machines
that you want to configure identically. Click on this icon and select whether you wish to
Load or Save the package list, then select the medium in the following screen and click
on OK.

9. User Management
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9.1. Administrator (root) Password
The Root Password is Key to Your System Security.  The root user is the system
administrator and is the only user authorized to make updates, add users, change the overall
system configuration, and so on. In short, root can do everything! That's why you must
choose a password which is difficult to guess: DrakX tells you if the password you chose
is too simple. Depending on the security level you chose, you're not forced to enter a
password, but we strongly encourage you to do so. Linux is just as prone to operator error as
any other operating system. Since root can overcome all limitations and unintentionally
erase all data on partitions by carelessly accessing the partitions themselves, becoming
root must be difficult.

Choose the Right Password.  The password should be a mixture of alphanumeric char-
acters and its minimum length will vary according to the chosen security level. Never write
down root's password — it makes it far too easy to compromise your system. However,
don't make the password too long or too complicated because you must be able to remem-
ber it too!

Check your password is secure enough

User management application can help you to check your password is strong
enough. In password field, you will see an icon coming as you are entering your

password. The  icon means your password is much too weak and could

be broken in a few seconds. The  icon means your password is rather

secure but you could have a much better one. Finally the  icon means your
password is really secure, you should not have any problem using it.

Enter the Password, Twice.  The password won't be displayed on screen as you type
it. To reduce the chance of a blind typing error you have to enter the password twice.

9.2. Enter a User
Create a User.  You are first asked for a real name. DrakX uses the first word you type
in this field and copies it, all in lowercase, to the Login name  field, which is the name this
user must enter to log on to the system. Then enter a password, twice (for confirmation).
From a security point of view, a non-privileged (regular) user's password isn't as crucial
as the root password, but that's no reason to neglect it by making it too simple: after all,
your  files could be the ones at risk.
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Linux is a Secure Multi-User System.  You can add other users. Refer to Section 12,
“Checking Miscellaneous Parameters” [191]. Each user may have his own preferences,
files and so on. But unlike the system administrator called root, the user you create at
this point is not authorized to change anything except its own files and configurations,
protecting the system from unintentional or malicious changes which could have a serious
impact.

More options for users accounts

Clicking on Advanced allows you to change the default shell for that user (bash
by default), and to manually choose the user and group IDs for that user.

By default, new installation of Mandriva Linux comes with a guest account
(Refer to Section 8, “Managing Users and Groups” [114]. You can disable it by
unchecking Guest account enabled.

10. Network Access Configuration

You are now offered to configure your Internet access. Simply choose the default connec-
tion type you wish to use with your system, and follow the instructions.
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For more information about how to configure your network, see Section 2, “Network and
Internet Connection Management” [75].

11. Graphical Interface Configuration

If the installer was not able to automatically configure your graphical display, this step
allows you to do so manually. Simply follow the instructions, choosing the appropriate
configuration corresponding to your hardware.
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12. Checking Miscellaneous Parameters

12.1. Summary

 As a review, DrakX presents a summary of information it gathered about your system.
Depending on the hardware installed on your machine, you may have some or all of the
following entries. Each entry is made up of the hardware item to be configured, followed
by a quick summary of the current configuration. Click on the corresponding Configure
button to make any changes.

• Timezone:  by default, DrakX deduces your time zone based on the country you have
chosen. You can click on the Configure  button if this is not correct. See Section 12.2,
“Time Zone Options” [193].

•  Country / Region: check the current country selection. If you're not in the country
selected by DrakX, click on the Configure  button and choose the correct one. If your
country isn't in the displayed list, click on Other Countries  to get a complete country list.



Summary

192

• Bootloader: to change your bootloader configuration. This should be reserved to ad-
vanced users. Refer to the printed documentation or the in-line help about bootloader
configuration in the Mandriva Linux Control Center.

• User Management: you can add other users for example, for each of your friends, your
father, your sister, etc. Click on Configure  then enter a user name and a password as
you did in previous steps.

Linux is a secure multi-user system. Each user may have his own preferences, files and
so on. But unlike the system administrator called root, the user you create at this point
is not authorized to change anything except its own files and configurations, protecting
the system from unintentional or malicious changes which could have a serious impact
on it.

•  Services: with this entry you can fine tune which services are run on your machine. If
you plan to use this machine as a server it's a good idea to review this setup.

•  Keyboard: check the current keyboard mapping configuration and change it if neces-
sary.

•  Mouse: verify the current mouse configuration and change it if necessary.

•  Sound card: if a sound card is detected on your system, it is displayed here. If you
notice the sound card isn't the one actually present on your system, you can click on the
button and choose a different driver.

• Graphical Interface: by default, DrakX configures your graphical interface with a res-
olution that best matches your video card and monitor combination. If that doesn't suit
you, or DrakX could not automatically configure it (not configured is displayed), click
on Configure  to reconfigure your graphical interface. You can click on Help from
within the configuration wizard to benefit from full in-line help.

•  Network: if you wish to configure your Internet or local network access, you can do
so from here. Refer to the printed documentation or use the Mandriva Linux Control
Center after the installation has finished to benefit from full in-line help.

•  Proxies: allows you to configure HTTP and FTP proxy addresses if the machine you're
installing on is to be located behind a proxy server.

•  Security Level : this entry allows you to define the security level.  As a rule of thumb,
the security level should be set higher if the machine is to contain crucial data, or if it's to
be directly exposed to the Internet, or hosting many users. The trade-off is that a higher
security level is generally obtained at the expense of ease of use.

If you do not know what to choose, read the descriptions, or keep the default option. You
will be able to change it later with the draksec tool in the Mandriva Linux Control Center.
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Fill the Security Administrator  field with the e-mail address of the person responsible
for security. Security-related messages will be sent to that address.

•  Firewall : if you plan to connect your machine to the Internet, it's a good idea to protect
yourself from intrusions by setting up a firewall. Consult the corresponding chapter of
the Starter Guide Section 2, “Securing your Internet Access via DrakFirewall” [154]
for details about firewall settings.

12.2. Time Zone Options

This setup allows you to refine the time zone you are currently located in. After you've
chosen the location nearest to your time zone, two more options for time management are
shown.

Date, Clock & Time Zone Settings
Linux manages time in UTC (Coordinated Universal Time) and translates it to local
time according to the time zone you selected. If the machine also hosts another oper-
ating system that doesn't handle time the same way, it's better to select the hardware
clock set to local time option.

NTP Server
If you check the Automatic time synchronization option the system clock will be
regulated automatically by connecting to a remote time server on the Internet. For this
feature to work, you must have a working Internet connection. We recommend that
you choose a time server located near you or the default All servers entry which will
select the best server for you. This option actually installs a time server which can be
used by other machines on your local network as well.
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12.3. Configuring X, the Graphical Server

 X (for X Window System) is the heart of the Linux graphical interface on which all the
graphical environments (KDE, GNOME, AfterStep, WindowMaker, etc.) bundled with
Mandriva Linux rely on.

Graphic Card
If everything works fine, the installer should detect and configure the video card in-
stalled on your machine. If the detection or configuration is incorrect, you can choose
the card installed on your system from a list.

Monitor
If the installer fails to detect or configure your monitor properly, you can choose the
monitor which is connected to your computer from the displayed list.

Resolution
Here you can choose the resolution and color depth from those available for your
graphics hardware. Choose the one which best suits your needs (you will be able to
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make changes after the installation). A sample of the chosen configuration is shown
in the monitor picture.

Test

This entry may not appear if your hardware does not allow testing.

The system tries to open a graphical screen at the desired resolution. If you see the
test message during the test and answer Yes, then DrakX will proceed to the next
step. If you don't see it, it means that some part of the auto-detected configuration was
incorrect and the test automatically ends after a few seconds and returns you to the
menu. Change settings until you get a correct graphical display.

Options

Graphic card options
Depending on your hardware capabilities, you can choose to activate or disable
specific features such as acceleration or special visual effects (transparency).

Graphical interface at startup
This option allows you to choose whether you want your machine to automatically
switch to a graphical interface at boot. Obviously, you may want to untick the
box if your machine is to act as a server, or if you were not successful in getting
the display configured.
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13. It's All Done!

 There you are. The installation is now complete and your Linux system is ready to be used.
Just click on Reboot  to restart the system. Remember to remove the installation media.
The first thing you should see, after your computer has finished doing its hardware tests, is
the bootloader menu, which allows you to choose between the OSes your system can boot.

14. How to Uninstall Linux

Removing partitions on your hard drive will inevitably result in the loss of all
data stored on those partitions. Please make sure you've backed up all of the
data you want to keep before proceeding.

  If for any reason you want to uninstall Mandriva Linux, you can do so. The process of
uninstalling Mandriva Linux is done in two steps:
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1. a. To do so, reboot your computer with the installation CD or DVD (see Section 1,
“The Mandriva Linux Installer” [175]).

b. Choose the Rescue System option.

c. In the new menu that appears, choose the Restore Windows Boot Loader  option,
then press Enter  to write the MBR with a Windows® one.

2. These are usually partitions hosting ext3 file systems and the Swap partition. You
can also replace them with a single partition using fdisk.

a. Still in rescue mode, select option Go to console .

b. Run fdisk /dev/sda (if the hard disk containing Mandriva Linux is other than the
1st disk, change /dev/sda accordingly).

c. Use the p command to display partition information, and then use the d com-
mand to delete all unneeded partitions.

d. If you want to create a single partition, use the c command, specify 1 as the
partition number, make it use all of the space available, and when asked for the
partition type, use the L command to list the supported partition types and choose
the one for the OS you plan to install later.

Some examples:

• c for a FAT32 (Windows® 9x) partition

• 7 for a NTFS (Windows® NT/ Windows® 2000/ XP/ Windows Vista®) par-
tition,

• 83 for a Linux partition.

e. Finally use the w command to write changes back to disk.

3. Once this is done, just reset or shutdown the machine using the corresponding buttons.
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Chapter 15. Introduction
to the Command Line

 Even if using graphical applications is very comfortable and easy for most people, the
command line is a very powerful interface to interact with your system. The shell's main
asset is the number of existing utilities: there are thousands of them, and each utility is
devoted to a particular task. We look at a very small number of these utilities hoping that
you will feel more comfortable interacting with your system through the command line.

 Choose Tools → Konsole Terminal  from the main menu to get a terminal win-
dow to have access to the command line. By default you will be “inside” your personal
directory, named after your user name: /home/your_user_name.

1. File Manipulation
All your data is contained within files: office documents, songs, movies, etc. We present
some commands to organize and manage those files.

1.1. List the Contents of a Directory
  ls (LiSt) is equivalent to the DOS command dir. Its syntax is as follows:

ls <directory> 

The most common options are:

• -R: recursively list the contents of the directory and all its subdirectories. Please note
that before displaying a directory's contents the name of the directory itself is shown.

• -l: use a long listing format. Details about the file such as the file's type, permissions,
owner and size are displayed.

• -a: show also hidden files. In UNIX ® systems, all files whose names start with a period
(.) are hidden. Use this option to show such files when listing a directory. If you don't
want the current directory and its parent (namely, . and ..) to be displayed use the -
A option instead.

Some examples:

• ls -lA /tmp/movies /tmp/images: list the contents of both the movies and images
directories inside the /tmp directory, displaying file details and hidden files, but not
displaying the . and .. entries for each directory;
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• ls -R ~/: display, recursively, all the files and directories you have inside your personal
directory.

1.2. Copy
   cp (CoPy) is equivalent to the DOS commands copy and xcopy but has more options.
Its syntax is as follows:

cp  <file|directory> [file|directory -..] <destination>

The most common options are:

• -R: recursive copy; mandatory for copying a directory, even an empty directory.

• -f: replaces any existing files without requesting confirmation. Use with care.

• -a: archive mode, preserves all file attributes on the copy and performs a recursive copy.

• -v: verbose mode, displays all actions performed by cp.

Some examples:

• cp -f /tmp/images/* images/: copies all files in the /tmp/images directory to the
images directory located in the current directory. It doesn't request confirmation if a
file is going to be overwritten.

• cp -vR docs/ /shared/mp3s/* mystuff/: copies the whole docs directory, plus all files
in the /shared/mp3s directory to the mystuff directory, displaying all actions per-
formed.

• cp foo bar: makes a copy of the foo file with the name bar in the current directory.

1.3. Move
     mv (MoVe) is equivalent to the DOS command move. Its syntax is as follows:

mv  <file|directory> [file|directory...] <destination>

Note that when you move multiple files the destination must be a directory. To rename a
file you simply move it to the new name.

The most common options are:

• -f: forces the operation. No warnings are given if an existing file is to be overwritten.
Use with care.

• -v:  verbose mode, reports all changes and activity.
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Some examples:

• mv /tmp/pics/*.png .: move all files in the /tmp/pics directory whose names end
with .png to the current directory.

• mv foo bar: rename file foo to bar. If a bar directory already existed, the effect of
this command would be to move file foo or the whole directory (the directory itself
plus all files and directories in it, recursively) into the bar directory.

• mv -vf file* images/ trash/: move, without requesting confirmation, all files in the cur-
rent directory whose names begin with file, together with the entire images direc-
tory to the trash directory, and show each operation carried out.

1.4. Remove

   The rm command (ReMove) is equivalent to the DOS commands del and deltree, but
has more options. Its syntax is as follows:

rm <file|directory> 

The most common options are:

•  -r, or -R: delete recursively. This option is mandatory for deleting a directory, empty
or not. However, you can also use rmdir to delete empty directories.

• -f: forces deletion of the files or directories. Use with care.

Some examples:

• rm images/*.jpg file1: deletes all files with names ending in .jpg in the images
directory and deletes file1 in the current directory.

• rm -Rf images/misc/ file*: deletes, without requesting confirmation, the whole directo-
ry misc in the images directory, together with all files in the current directory whose
names begin with file.

Using rm deletes files irrevocably. There is no easy way to restore them! Be
extra careful when using the -f option to skip confirmation request to ensure
that you do not delete something by mistake.

1.5. Create a Directory

  mkdir (MaKe DIRectory) is equivalent to the DOS commands mkdir and md. Its syntax
is as follows:
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mkdir <directory>

Only the -p option is worth noting. It does two things:

1. creates parent directories if they did not exist previously. Without this option, mkdir
would just fail, complaining that these directories do not exist;

2. returns silently if the directory you wanted to create already exists. If the -p option
is not specified, mkdir sends back an error message, complaining that the directory
already exists.

Some examples:

• mkdir foo: creates a directory foo in the current directory;

• mkdir -p images/misc: creates the misc directory in the images directory, creating
first the latter if it does not exist.

1.6. Change the Working Directory

The current working directory, symbolized by a period (.), is the place on the file system
you are “standing onto”. The double period (..) symbolizes the parent directory of the
current one which is “one level up”(or back) on the file system structure.

  cd (Change Directory) lets you navigate the file system structure. Its syntax is as follows:

cd <directory>

Some examples:

• cd /tmp/images: changes to the images directory inside the /tmp directory;

• cd -: changes to the previous current working directory;

• cd: changes to your personal (home) directory;

• cd ~/images: changes to the images directory inside your personal directory.

Type pwd to display the directory you are currently located in.

2. Process Manipulation
From the system's point of view, applications run in one or many processes, consuming
system resources, such as memory and processor time. We present some commands to
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monitor and manage those processes, and as a consequence, the applications they belong
to.

2.1. Information on Processes

 The ps command displays a list of processes currently running on the system, according
to the criteria you set.

Running ps without arguments will show only processes initiated by you and attached to
the terminal you are using:

$ ps
  PID TTY       TIME CMD
18614 pts/3 00:00:00 bash 20173 pts/3 00:00:00 ps

The most common options are:

• a: displays processes started by all users;

• x: displays processes launched from any terminal, not just yours (or even from no ter-
minal at all);

• u: displays for each process the name of the user who started it and the time at which
it was started.

2.2. Controlling Processes

 Processes are controlled by means of signals. The kill and killall commands are used to
send signals to processes. The kill command requires a process number as an argument,
while killall requires a process name.

Please bear in mind that processes react differently to the same signals. You
cannot expect a priori that the process behaves as you thought it would when
you send it a signal.

kill <process_number>

killall <process_name>

Signals can be specified by number or name. Execute kill -l to view a list of available
signals. The most commonly used signals are:

• TERM or 15: this is the default signal sent if the signal name or number is omitted. It
terminates the process gracefully.
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• STOP or 19: this signal is used to temporarily pause a process. Send signal CONT or
18 to continue a paused process.

• KILL or 9: this signal is used to force process termination. It is commonly used to end a
process that is not responding anymore (or “frozen”). It terminates the process abruptly.

Some examples:

• kill 785: asks the process identified by the number 785 to finish execution giving the
process the chance to perform any clean-up operation it needs;

• kill -KILL 785: forces termination of the process identified by the number 785 with-
out giving the process the chance to perform any clean-up operation. The process ends
immediately;

• killall -TERM make: asks all processes named make launched by this user to finish
execution.

Whatever happens, you will only control your own processes (unless you are root) so
you do not need to worry about other users' processes since they will not be affected.

2.3. Mixing ps and kill: top
top is a program which simultaneously fulfills the functions of ps and kill, and is also
used to monitor processes in real-time giving information about CPU and memory usage,
running time, etc., as shown in Figure 15.1, “Monitoring Processes with top” [204].

Figure 15.1. Monitoring Processes with top



Commands Documentation

205

The top utility is entirely keyboard controlled. Commands are case-sensitive. You can
access help by pressing h. Its most useful commands are the following:

• k: sends a signal to a process. You are asked for the process' PID followed by the
number or the name of the signal to be sent (TERM or 15, by default);

• M: sorts display of processes by the amount of memory they take up (field %MEM);

• P: sorts display of processes by the CPU time they take up (field %CPU): this is the
default sorting method;

• u: displays a given user's processes. You are asked to enter the user's name, not his
UID. If you do not enter any name, all processes are displayed;

• i: by default, all processes, even sleeping ones, are displayed. This command ensures
that only processes currently running are displayed (processes whose STAT field shows
R, Running) and not the others. Using this command again takes you back to showing
all processes.

3. Commands Documentation
If you want to know more about a given command options and usage, you can consult the
commands manual, or “man page”. The syntax for the man command is:

man <man_page>

Sections are like different chapters of a big book, each one specific to an aspect of the
system. Some commands might appear indifferent sections, so you might need to specify
which section you are interested in.

Sections are numbered from 1 to 9, and there's a 10 th one, called n. You can also specify a
to display all matching sections for a given man page. If you omit the section parameter,
the first matching man page is displayed.

man has its own man page, execute man man to display it.

4. Further Reading
Here we've just “scratched the surface” on the command line and its powerful tools.
If you want to read more you can try the  GNU Linux Tools Summary Guide [http://
www.tldp.org/LDP/GNU-Linux-Tools-Summary/html/index.html] from The Linux Doc-
umentation Project website [http://www.tldp.org].

http://www.tldp.org/LDP/GNU-Linux-Tools-Summary/html/index.html
http://www.tldp.org/LDP/GNU-Linux-Tools-Summary/html/index.html
http://www.tldp.org/LDP/GNU-Linux-Tools-Summary/html/index.html
http://www.tldp.org
http://www.tldp.org
http://www.tldp.org
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Appendix A. Where to
Get Documentation

  Apart from the manuals included with Mandriva Linux, documentation is available from
many sources. The next few pages contain suggestions which you might find useful.

1. Mandriva Linux-Specific Documentation

1.1. Mandriva's Own Documentation

The manual you have in hand contains most of the documentation available for home
and corporate usage. You may also consult our on-line versions for other products in our
documentation pages [http://doc.mandriva.com/].

Some of these manuals may be available in your Mandriva Linux pack, in the mandri-
va-doc-MANUAL_NAME-en package. Once installed, menu entries of the form Docu-

mentation  → Mandriva Linux MANUAL_NAME in English  are available. Choose then
to open the manual in a browser and select the format you want to use.

Installing manuals

You can check which manuals are available in your distribution by going to the
Control Center and choosing the Installing and Removing Software tool. You
can then search for mandriva-doc.

Mandriva Control Center Inline Help.  All Mandriva Linux Control Center tools have

online help, which you can access through Help → Help from Mandriva Linux Control
Center's menu: the browser opens up with Mandriva Linux Control Center's help.

1.2. Internet Resources

 Internet information sources are widespread and many web sites are devoted to Linux and
its use or configuration. However, some sources of information are better than others.

Your preferred source of information should be the Mandriva Linux official web site
[http://www.mandrivalinux.com]. In particular, check out the support section [http://
expert.mandriva.com]. You can also check out the Mandriva Community Wiki [http://
wiki.mandriva.com]. It offers lots of resources, information and documentation, which will
certainly interest Mandriva Linux users.

http://doc.mandriva.com/
http://doc.mandriva.com/
http://doc.mandriva.com/
http://www.mandrivalinux.com
http://www.mandrivalinux.com
http://expert.mandriva.com
http://expert.mandriva.com
http://expert.mandriva.com
http://wiki.mandriva.com
http://wiki.mandriva.com
http://wiki.mandriva.com


Linux Useful Resources

208

1.2.1. Mandriva Security Advisories

The Mandriva Security Advisories web site [http://www.mandriva.com/security/] is
Mandriva's very own security site. It covers package vulnerabilities.

1.2.2. Mandriva E-training

The Mandriva eTraining web site [http://etraining.mandriva.com/] allows you to buy qual-
ity Linux training to improve your Open Source knowledge. You can access this web site
by using your Mandriva “My” account [https://my.mandriva.com/]. A free demo for some
training modules is available, and many more if you are a registered Club member.

2. Linux Useful Resources

Abstract

In this section, we present resources useful for any Linux distribution. Most are not written
specifically for Mandriva Linux, but may nevertheless prove useful.

2.1. The /usr/share/doc Directory
Most packages include their own documentation in one of the sub-directories of /usr/
share/doc, which will be named after the specific package. Mandriva Linux's own doc-
umentation, when installed, is available in the /usr/share/doc/mandriva/ direc-
tory.

2.2. Web Resources

2.2.1. Security-Related Web Sites

Security Focus [http://www.securityfocus.com/]
Reviews current attacks and publishes vulnerability advisories for a great number of
products, including Mandriva Linux.

Linux Security [http://www.linuxsecurity.com/]
Entirely devoted to Linux and includes news, advisories, newsletters, and many other
resources such as documentation, forums, tools, etc. Check out the site's documenta-
tion page [http://www.linuxsecurity.com/docs].

Linux dot com [http://www.linux.com]
Excellent site regularly fed with articles on present security issues. It also features ar-
ticles about desktop, sound, and more. You should particularly check out the HOWTO
[http://howtos.linux.com/] section.

http://www.mandriva.com/security/
http://www.mandriva.com/security/
http://etraining.mandriva.com/
http://etraining.mandriva.com/
https://my.mandriva.com/
https://my.mandriva.com/
http://www.securityfocus.com/
http://www.securityfocus.com/
http://www.linuxsecurity.com/
http://www.linuxsecurity.com/
http://www.linuxsecurity.com/docs
http://www.linuxsecurity.com/docs
http://www.linuxsecurity.com/docs
http://www.linux.com
http://www.linux.com
http://howtos.linux.com/
http://howtos.linux.com/
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2.2.2. Other Linux Web Sites

Of the many existing web sites, here are some with the most information:

Linux Online! [http://www.linux.org/]
One of the very first sites devoted to Linux, it contains a whole slew of links to other
useful sites.

Freshmeat [http://freshmeat.net/]
This is the place to visit to get the latest applications available in the Linux world.

Linux Weekly News [http://www.lwn.net/]
One of the most exhaustive Linux publications available, it covers everything from the
latest security alerts to new distributions, information about current and past kernels,
books, and a weekly newsletter (for subscribers only).

And, of course, remember your favorite search engines. Generally speaking, they are the
most practical information seeking tools. A few carefully chosen keywords in a search
engine often produce the answers you need for your specific problem. With Google
™, you can even make a Linux-oriented search by visiting its Linux section [http://
www.google.com/linux].

2.3. The Man Pages

Abstract

The Manual Pages (also known as “man pages”) are a set of exhaustive documents, which
help you acquire better knowledge of Linux commands. The latter are usually issued
through the “command line” and allow great control over your system. Although these
man pages might seem discouraging at first, they offer great detail and we encourage you
to browse through them when a problem occurs.

This should be your primary source of information for shell commands. Almost all
commands have a manual page. Other items, such as certain configuration files, library
functions for programmers and others system aspects also have their own man pages.

Man page contents are arranged in different sections. References to these are made in the
following manner: for example, open (2) , fstab (5) respectively refer to the open page in
section 2 and the fstab page in section 5.

The easiest way to view a man page is through a browser. Using Konqueror, type
man:/man(1) in the Location bar for the man page for the man command to
be displayed. For example, to display the man page for fstab (5) , type man:/
fstab(5) in the Location field.

http://www.linux.org/
http://www.linux.org/
http://freshmeat.net/
http://freshmeat.net/
http://www.lwn.net/
http://www.lwn.net/
http://www.google.com/linux
http://www.google.com/linux
http://www.google.com/linux
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To display a man page in a terminal (or shell), type man. The syntax to obtain a man
page is:

man <manual page>

man also has documentation, which can be obtained by typing man man. Manual pages
are formatted and then displayed using the less  pager.

The names of the manual pages and their relevant sections appear at the top of each page.
At the bottom of the page are references to other pages with related subjects (usually in
the SEE ALSO section).

If you cannot find the right manual page — for example, you want to use the mknod
function in one of your programs but you end up on the mknod command page — make
sure you spell out the section explicitly. In our example: man 2 mknod. If you forget the
exact section, man -a mknod will read through all the sections looking for pages named
mknod.

2.4. Info Pages

info pages complete the documentation included in the manual pages. The command to
access info pages from a terminal is info.

Info pages are organized using a tree structure, the top of which is called dir. From there,
you can access all info pages.

info may be called up in two ways: either by omitting any argument, thereby placing you
at the very top of the tree structure, or by adding a command or a package name, which
(if it exists) opens the relevant page. For example:

info emacs

In the info pages:

* Buffers::

indicates a link. Moving the cursor to this link (using the arrow keys) and pressing Enter
takes you to the corresponding info page.

You may also use the following keyboard shortcuts:

• u: for Up, takes you up one level;

• n: for Next, takes you to the next info page on the same tree-structure level;

• p: for Prev, takes you back to the previous info page.
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• q: for Quit, exits the info page viewer.

A great number of commands may be listed by pressing the ? key.

You can also display info pages in Konqueror by using the info:/ prefix in
your URL. For example, to display the info page for make, type info:/make
in the Location field.

This makes navigation through the info pages much easier.

2.5. HOWTOs
HOWTOs published by the TLDP (The Linux Documentation Project) are available in many
languages and cover many aspects of your system. As long as the proper packages are
installed (the howto-html-en package for the English edition), HOWTOs provide you
with an answer to a specific question or a solution to a problem. The documentation is
located in the /usr/share/doc/HOWTO/HTML/en/ directory. These are HTML files
readable and printable with any web browser.

The list is quite long. To get an idea of its length, consult the  TLDP web site [http://
www.tldp.org/HOWTO/HOWTO-INDEX/howtos.html]. You can have the documents lo-
cally by installing the howto-html package corresponding to your language. You can

then access them through the Documentation  → Howtos  menu.

When you encounter a complex problem, start by reading the corresponding HOWTO,
if available. Not only will you be given a solution to your problem, but you will also
learn a great deal at the same time. Examples of what is covered range from networking
(NET-3-HOWTO), sound card configuration (Sound-HOWTO), the writing of CD media
(CD-Writing-HOWTO) as well as NIS and NFS configuration and much much more.

An important step is to check the modification dates of the HOWTO documents —
such as the publication date located at the beginning of the document — to make
sure they are up-to-date. Otherwise, the information may be invalid. Watch out
for old HOWTOs relating to hardware configuration: Linux evolves very quickly
in the hardware area. Something else to keep in mind: in the free software world,
the term “old” carries even more weight than in IT in general: free software may
be considered old after being around for only fifteen days!

HOWTOs are available on-line on TLDP [http://www.tldp.org/] web site and are
likely to be slightly more up-to-date there. Have a look at the following as well:
HOWTOs classified by categories [http://www.tldp.org/HOWTO/HOWTO-IN-
DEX/categories.html], and  FAQ s [http://www.tldp.org/docs.html#faq].

http://www.tldp.org/HOWTO/HOWTO-INDEX/howtos.html
http://www.tldp.org/HOWTO/HOWTO-INDEX/howtos.html
http://www.tldp.org/HOWTO/HOWTO-INDEX/howtos.html
http://www.tldp.org/
http://www.tldp.org/
http://www.tldp.org/HOWTO/HOWTO-INDEX/categories.html
http://www.tldp.org/HOWTO/HOWTO-INDEX/categories.html
http://www.tldp.org/HOWTO/HOWTO-INDEX/categories.html
http://www.tldp.org/docs.html#faq
http://www.tldp.org/docs.html#faq
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Appendix B. About the
Making of this Manual

1. Technical Infrastructure

This manual is written and maintained by NeoDoc [http://www.neodoc.biz]. Translations
are assured by NeoDoc, Mandriva and other translators.

 This document was written in DocBook XML. The set of files involved were man-
aged using the  Calenco Collaborative XML Content Management System (CMS) [http://
www.calenco.com]. The XML source files were processed by saxon, and fop using a cus-
tomized version of Norman Walsh's stylesheets. Screen shots were taken using xwd or
GIMP and converted with convert (from the ImageMagick package). Diagrams were cre-
ated with Inkscape. All these programs are free software and most of them are available
in your Mandriva Linux distribution.

2. Help Improve Mandriva Linux Documentation

In the open-source philosophy, contributors are always welcomed! Updating the Mandriva
Linux documentation pool is quite a task. You could provide help in many different ways.
In fact, the documentation team is constantly looking for talented volunteers to help us to
accomplish the following tasks:

• writing or updating;

• translating;

• copy editing;

• XML/XSLT programming.

If you have lots of time, you can write or update a whole chapter; if you speak a foreign
language, you can help us translate our manuals; if you have ideas on how to improve the
content, let us know; if you have programming skills and would like to help us enhance
the Calenco CMS [http://www.calenco.com], join in. And please don't hesitate to contact
us if you find any mistakes in the documentation so we can correct them!

 For any information about the Mandriva Linux documentation project, please contact the
documentation administrator [mailto:documentation@mandriva.com] or visit the  Man-
driva Linux Documentation Project Pages [http://wiki.mandriva.com/en/Development/
Tasks/Documentation].

http://www.neodoc.biz
http://www.neodoc.biz
http://www.calenco.com
http://www.calenco.com
http://www.calenco.com
http://www.calenco.com
http://www.calenco.com
mailto:documentation@mandriva.com
mailto:documentation@mandriva.com
http://wiki.mandriva.com/en/Development/Tasks/Documentation
http://wiki.mandriva.com/en/Development/Tasks/Documentation
http://wiki.mandriva.com/en/Development/Tasks/Documentation
http://wiki.mandriva.com/en/Development/Tasks/Documentation
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Since June 2004 the Mandriva Linux documentation and the development of
Calenco is handled by  NeoDoc [http://www.neodoc.biz].

http://www.neodoc.biz
http://www.neodoc.biz
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Appendix C. The GNU
General Public License

Abstract

The following text is the GPL  license that applies to most programs found in Mandriva
Linux distributions. The original can be found at the GNU website [http://www.gnu.org/
copyleft/gpl.html].

Version 2, June 1991 Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple
Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

1. Preamble
The licenses for most software are designed to take away your freedom to share and change
it. By contrast, the GNU General Public License is intended to guarantee your freedom
to share and change free software — to make sure the software is free for all its users.
This General Public License applies to most of the Free Software Foundation's software
and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You
can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free
software (and charge for this service if you wish), that you receive source code or can get
it if you want it, that you can change the software or use pieces of it in new free programs;
and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these
rights or to ask you to surrender the rights. These restrictions translate to certain responsi-
bilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you
must give the recipients all the rights that you have. You must make sure that they, too,
receive or can get the source code. And you must show them these terms so they know
their rights.

We protect your rights with two steps:

1. copyright the software, and

http://www.gnu.org/copyleft/gpl.html
http://www.gnu.org/copyleft/gpl.html
http://www.gnu.org/copyleft/gpl.html
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2. offer you this license which gives you legal permission to copy, distribute and/or modify
the software.

Also, for each author's protection and ours, we want to make certain that everyone un-
derstands that there is no warranty for this free software. If the software is modified by
someone else and passed on, we want its recipients to know that what they have is not the
original, so that any problems introduced by others will not reflect on the original authors'
reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid
the danger that redistributors of a free program will individually obtain patent licenses,
in effect making the program proprietary. To prevent this, we have made it clear that any
patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

2. Terms and conditions for copying,  distribution  and
 modification

• 0. This License applies to any program or other work which contains a notice placed
by the copyright holder saying it may be distributed under the terms of this General
Public License. The “Program”, below, refers to any such program or work, and a “work
based on the Program” means either the Program or any derivative work under copyright
law: that is to say, a work containing the Program or a portion of it, either verbatim or
with modifications and/or translated into another language. (Hereinafter, translation is
included without limitation in the term “modification”.) Each licensee is addressed as
“you”.

Activities other than copying, distribution and modification are not covered by this Li-
cense; they are outside its scope. The act of running the Program is not restricted, and
the output from the Program is covered only if its contents constitute a work based on
the Program (independent of having been made by running the Program). Whether that
is true depends on what the Program does.

• 1. You may copy and distribute verbatim copies of the Program's source code as you
receive it, in any medium, provided that you conspicuously and appropriately publish
on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all
the notices that refer to this License and to the absence of any warranty; and give any
other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your
option offer warranty protection in exchange for a fee.
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• 2. You may modify your copy or copies of the Program or any portion of it, thus forming
a work based on the Program, and copy and distribute such modifications or work under
the terms of Section 1 above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed
the files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part
contains or is derived from the Program or any part thereof, to be licensed as a whole
at no charge to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to
print or display an announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide a warranty) and that
users may redistribute the program under these conditions, and telling the user how
to view a copy of this License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on the Program is
not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that
work are not derived from the Program, and can be reasonably considered independent
and separate works in themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of
the whole must be on the terms of this License, whose permissions for other licensees
extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work
written entirely by you; rather, the intent is to exercise the right to control the distribution
of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Pro-
gram (or with a work based on the Program) on a volume of a storage or distribution
medium does not bring the other work under the scope of this License.

• 3. You may copy and distribute the Program (or a work based on it, under Section 2)
in object code or executable form under the terms of Sections 1 and 2 above provided
that you also do one of the following:

a. Accompany it with the complete corresponding machine-readable source code,
which must be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,
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b. Accompany it with a written offer, valid for at least three years, to give any third
party, for a charge no more than your cost of physically performing source distribu-
tion, a complete machine-readable copy of the corresponding source code, to be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used
for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corre-
sponding source code. (This alternative is allowed only for noncommercial distribu-
tion and only if you received the program in object code or executable form with
such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifi-
cations to it. For an executable work, complete source code means all the source code
for all modules it contains, plus any associated interface definition files, plus the scripts
used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally dis-
tributed (in either source or binary form) with the major components (compiler, kernel,
and so on) of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from
a designated place, then offering equivalent access to copy the source code from the
same place counts as distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

• 4. You may not copy, modify, sublicense, or distribute the Program except as expressly
provided under this License. Any attempt otherwise to copy, modify, sublicense or dis-
tribute the Program is void, and will automatically terminate your rights under this Li-
cense. However, parties who have received copies, or rights, from you under this License
will not have their licenses terminated so long as such parties remain in full compliance.

• 5. You are not required to accept this License, since you have not signed it. However,
nothing else grants you permission to modify or distribute the Program or its derivative
works. These actions are prohibited by law if you do not accept this License. Therefore,
by modifying or distributing the Program (or any work based on the Program), you
indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

• 6. Each time you redistribute the Program (or any work based on the Program), the
recipient automatically receives a license from the original licensor to copy, distribute
or modify the Program subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights granted herein. You are not
responsible for enforcing compliance by third parties to this License.
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• 7. If, as a consequence of a court judgment or allegation of patent infringement or for
any other reason (not limited to patent issues), conditions are imposed on you (whether
by court order, agreement or otherwise) that contradict the conditions of this License,
they do not excuse you from the conditions of this License. If you cannot distribute so
as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all. For exam-
ple, if a patent license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from distribution of
the Program.

If any portion of this section is held invalid or unenforceable under any particular cir-
cumstance, the balance of the section is intended to apply and the section as a whole is
intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
protecting the integrity of the free software distribution system, which is implemented
by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application
of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence
of the rest of this License.

• 8. If the distribution and/or use of the Program is restricted in certain countries either
by patents or by copyrighted interfaces, the original copyright holder who places the
Program under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the limitation as if written in
the body of this License.

• 9. The Free Software Foundation may publish revised and/or new versions of the Gen-
eral Public License from time to time. Such new versions will be similar in spirit to the
present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a ver-
sion number of this License which applies to it and "any later version", you have the
option of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Program does not specify a version
number of this License, you may choose any version ever published by the Free Soft-
ware Foundation.
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• 10. If you wish to incorporate parts of the Program into other free programs whose
distribution conditions are different, write to the author to ask for permission. For soft-
ware which is copyrighted by the Free Software Foundation, write to the Free Software
Foundation; we sometimes make exceptions for this. Our decision will be guided by
the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY
• 11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLI-
CABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPY-
RIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS
IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

• 12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED
TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY
WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMIT-
TED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENER-
AL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT
OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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